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Experiment no: 01 
Experiment Title: Introduction to EasyEDA 

 

 

Welcome to EasyEDA, a great web based EDA(Electronics Design Automation) tool for 
electronics engineers, educators, students, makers and enthusiasts. 

There is no need to install any software. Just open EasyEDA in any HTML5 capable, standards 
compliant web browser. 

Whether you are using Linux, Mac or Windows, it is highly recommended to use Chrome or 
Firefox as your browser. You can also download EasyEDA client. 
EasyEDA has all the features you expect and need to take your design rapidly and easily from 
conception through to production. 

EasyEDA Editor: 

https://easyeda.com/editor 

Instruction: 

This tutorial document will be updated as changes are made to the EasyEDA editor. 

Tutorial for PDF 

EasyEDA-Tutorials.pdf 

EasyEDA Provides: 

Simple, Easy, Friendly, and Powerful drawing capabilities 

Works Anywhere, Anytime, on Any Device 

Real-time Team Cooperation 

Sharing Online 

Thousands of open-source projects 

Integrated PCB fabrication and Components purchase workflow 

API provided 

Script support 

Schematic Capture 

LTSpice-based Simulation 
Spice models and subcircuits create 
Waveform viewer and data export(CSV) 
Netlist export(Spice, Protel/Altium Designer, Pads, FreePCB) 
Document export(PDF, PNG, SVG) 
EasyEDA source file export(json) 
Altium Designer format export 
BOM export 

Multi-sheet schematics 

Schematic module 
Theme setting 
Document recovery 

PCB Layout 

Design Rules Checking(DRC) 
Multi-Layer, 6 copper layer supported 
Document export(PDF, PNG, SVG) 
EasyEDA source file export(json) 

https://easyeda.com/page/download
https://easyeda.com/editor
https://easyeda.com/forum/topic/PDF-EasyEDA-Tutorial-for-PDF-881302c7032b4d1697af1359ed9f6daa
https://jlcpcb.com/
https://lcsc.com/
https://www.analog.com/en/design-center/design-tools-and-calculators/ltspice-simulator.html


Altium Designer format export 
BOM export 
DXF export 
Photo view 
3D View 
Generate fabrication file(Gerber) 
Export Pick and Place file 
Auto Router 
PCB module 
Document recovery 

Import 

Altium/ProtelDXP ASCII Schematic/PCB 
Eagle Schematic/PCB/Libraries 
KiCAD Schematic/PCB/Libraries 
DXF 

Libraries 

More than 1,000,000 public Libraries(Symbol and Footprint) 
Library management 
Symbol/Subpart create and edit 
Spice symbol/model create and edit 
Libraries management 

Footprint create and edit 

 

 

Design Flow by Using EasyEDA 
 

 

You can design circuits easily using EasyEDA. The design flow is as shown here: 
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https://lcsc.com 
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Experiment no:02 
 
 
 

Experiment Title: UI Introduction 
 

 

EasyEDA Editor has a clear and friendly user interface. It has a short learning curve, and you 
will be productive in a short time. 

Filter 

To use the filter first select what module you need in the left navigation panel, and then you 
can find projects, files, parts, and footprints quickly and easily just by typing a few letters. For 
example, if you want to find all files containing “NE555” in the title, just type “555”. The 
filter is non-case sensitive. 

 

The Filter can only find projects, files, part titles, and names. It does not search the 
Descriptions and Content fields. 

Click the X to clear the filter. 

Navigation Panel 

The Navigation panel is especially important for EasyEDA: This is where you can find all of 
your projects, files, parts and footprints. 

Project 
Here you can find all your projects, both private or shared with the public, or fork them from 
someone else's. These options have a context menu found by right clicking and selecting 
Projects. You will get a menu tree like: 



 

 
EELib 

EElib means EasyEDA Libraries, it provides lots of components complete with simulation 
models, many of which have been developed for EasyEDA to make your simulation experience 
easier. 

Design Manager 
Design Manager, you can check each component and net wiring, and it provides DRC(Design 
rule check) to help improve your design. 



 

Library 



Contains schematic symbols and PCB footprints for many available components and projects. 
Your own libs and modules will show up here. 

 

LCSC 
If you want to buy components to finish your PCB, you should try the LCSC module. 
LCSC.com and EasyEDA are the same company. 
EasyEDA partners with China's largest electronic components online store by number of 
customers and product quantity shipped. https://lcsc.com. 
LCSC means Love Components? Save Cost! We suggest to our users to use LCSC parts to 
design. Why? 

Low minimum required quantities & Global Shipping. 
More Than 25,000 Kinds of Components. 
All components are genuine high quality. 
Ordering components is easy. 
Savings can exceed 40%. 
You can use LCSC component symbols and footprints directly in EasyEDA editor. 

JLCPCB 
JLCPCB.com, LCSC.com and EasyEDA are all part of the same company group. 
https://jlcpcb.com 
More than 200,000 customers worldwide trust JLC, 8000 + online orders per day, JLCPCB 
(Shenzhen JIALICHUANG Electronic Technology Development Co.,Ltd.), is the largest PCB 
prototype enterprise in China and a high-tech manufacturer specializing in quick PCB 
prototype and small-batch production. Affordable, high quality boards ae fully 
manufactured in China. Boards are fully e-tested. Pricing is clear and easy to understand. 

Top Menu 

Most EasyEDA features can be found on the top menu: 

 

You can find what you need easily and clearly. 

Preview Dialog 

The Preview dialog will help you choose components and footprints and can help you to 
identify schematics and PCB layouts. 

https://lcsc.com/
https://jlcpcb.com/


You can close or open this dialog with: 

Top Menu > View > Preview Window. 

 

The Preview Dialog has a resizing handle in the bottom right corner. 

The Preview Dialog can't be closed but double clicking on the top banner will roll up the 
panel or you can click the top right corner 

toggles it back to the selected size. 

Wiring Tools 

. Double clicking the top banner again 

The Wiring Tools are document type sensitive: different document types have different tools. 
 

Drawing Tools 

To keep EasyEDA's UI clean and sharp, the Wiring and Drawing tools palettes can be resized 
horizontally, rolled up or hidden so if you want to focus on drawing or have a smaller monitor, 
you can roll up or hide them to free up more monitor space and reduce the clutter. 

 

— 



Canvas Attributes 

You can find the canvas Properties setting by clicking in any blank space of the canvas. 
 

The background and grid colors and the style, size, visibility and snap attributes of the grid 
can all be configured. 

The canvas area can be set directly by the Width and Height or from the available preset 
frame sizes. 

Canvas 

This is where it all happens! This the area where you create and edit your schematics, PCB 
layouts, symbols, footprints, and other drawings. You also run simulations and display 
Waveform traces from here. 

 

 

 

 

 

 

 



Experiment no:03 
Experiment Title: Creating New Project or File 

 

 

Create Project 

After logging in, you can create a new project: 

File > New > Create a new project/Schematic..etc 
 

The Project concept is important in EasyEDA because it is the foundation of organizing your 
designs. 

 

Owner: You can change the owner of this project; you can change the owner to the team 
that you have joined. 
Title: Give it a title: this will show in the project tree in the left-hand panel. 
Path: EasyEDA allows you to set the path for the project, this is useful for sharing with 
your friends. It cannot be edited once it has been created. 
Description: Adding a short description helps you and anyone you are sharing this 
project with understand what the project is about. 



Once created, to modify your project, right click on it in the project tree in the left-hand panel: 

 

 

 

 

 

 

 

 

 

 

 
this will open a web page where you can edit your project: 

 

From here, you can change to publish or not, allow other people to comment on your project, 
or type a more detailed description of the project content. To help you make your project 
stand out or to maybe simply make a detailed description of your project easier to read, you 
can use Markdown syntax. 

Open Project 

You can open your created project using: 

Top Menu - File - Open Project 



 

Or click the Opened Project "open project" icon. 
 

Select the project and open it. 
 

 

Schematic Capture 
 

 

EasyEDA can create professional quality schematics. 



QFP 

 
 

Because EasyEDA has some simple but powerful drawing capabilities, you can create your own 
symbols either by copying existing symbols into your own library and then editing and saving 
them, or by drawing them from scratch. 

There is also a Symbol Wizard to quickly draw new symbols for DIP , and SIP . 
 

A feature of EasyEDA is that as well as extensive libraries of the usual simple “2D” graphical 
schematic symbols, it has a library of drawn “3D” component symbols, i.e. symbols that look 
like the physical components that they represent. 

Using the drawing features in symbol creation, your schematic can be built like this: 



Eagle 

Altium 

 
 

Another powerful feature is that it is possible to import symbols from Kicad , or 
libraries. 

 

 

PCB Layout 
 

 

When you are satisfied with your schematic design and simulation results, you can then 
quickly proceed to produce your finished and populated PCB without leaving EasyEDA. 

EasyEDA's PCB Design canvas helps you to quickly and easily lay out even complex multilayer 
designs from schematics you have already created in the Schematic canvas or directly as a 
layout with no schematic. 

Passing an EasyEDA Schematic into the PCB Design editor is as easy as clicking a button: 
Just click the Convert to PCB using: "Menu - Design - Convert to PCB". 

 

EasyEDA has extensive component footprints. You can also build up your own library of 
unusual and specialized parts by copying and modifying existing parts or from scratch 



using EasyEDA’s powerful footprint creation and editing tools. 

 

When working in the PCB Design canvas there is a PCB Design Manager which works in a 
similar way to the Schematic design canvas, this will help you locate items and navigate 
your way around. 
Left Navigation Panel > Design Manager 
The PCB Design Manager is a powerful tool for finding components, tracks (nets) and 
pads (Net Pads). 

Clicking on any item highlights the component and pans it to the center of the window. 

 

 

 

 

 

 

 

 

 

 

 
You can set up layers used in the PCB and their display colours and visibility using 

Top Menu - Tools - Layer Manager... 



.png 

The active layer and layer visibility can be selected using the Layers Toolbar. 

 

 

 

 

 

 

 

 
 

Default track widths, clearances and via hole dimensions can all be configured in the 
Design Rule Check dialog which is opened by: 

Top Menu > Design > Design Rule... 
 

The Design Rule Check (DRC) is created when beginning your board layout. It can also be 
modified at any time. Running a DRC is one of the last steps in checking your PCB design 
before you generate Gerber and Drill files for board manufacture and are ready to place 
your order for a finished PCB. 
The final step is to check the Gerber and Drill files using a software Gerber viewer. This is 
an easy to install and use Open Source Software Gerber Viewer: Gerbv:  
http://gerbv.geda-project.org/ 
While you are waiting for your PCB to be delivered or at any time it is needed, you can 
create a Bill of Materials (BOM) with: 

File > Export BOM... or Top Menu - Fabrication - BOM... 

 

 

 

 

 

 

 

 

 
 

You can produce professional quality SVG , or 
documentation. 

output files for your .pdf 

http://gerbv.geda-project.org/
http://gerbv.geda-project.org/


PCB Designs can be shared with colleagues and made public in the same way as Schematics. 
The size of PCB that you can produce using EasyEDA is almost unlimited: designs of over 
100cm * 100cm are possible … but you might need a powerful computer for that. 

EasyEDA supports up to 6 layer PCBs by default but it is capable of handling more, so if you 
need more layers then please contact us. 

Search footprints 

Searching footprints is the same as searching symbols by using Library in the Schematic 
editor. 

You can place the selected footprints in the canvas after a successful search. 

 
 
 

Libraries Management 
 

 

Thanks to the Free and Open Source Kicad Libs and some Open Source Eagle libs, EasyEDA 
now has 700,000+ components, which should be enough for most projects! 

With these libraries you can enjoy using EasyEDA without having to spend so much time 
hunting for or building schematic symbols and PCB footprints. 

Library 
On the left-side Navigation panel you will find "EElib" and "Library", just type what 
components you want and search. 

At Libraries: 

 
Steps: 

1. Choose the library type 
2. Type keywords such as "1k 0603" 
3. Click the search button 
4. Make your choice from the search results 

5. When you are done searching remove all the keywords 
Create Library 
EasyEDA supports creating your own symbols. After creation you can find your own 
components at Library > Symbols/Footprints > Workspace, and it is easy to manage 
your libraries. 



.PNG 

 
 

Transfer Libraries 
If you want to transfer your libraries to the team, you can do that in "User Center > 
Libraries > Personal". 

 

To prepare for the final assembly stage you can create a Bill of Materials (BOM) using: File > 
Export BOM... 

You can also produce professional quality SVG , or 
documentation. 

output files for your 

All EasyEDA Schematic Symbol and PCB Footprint libs are public, so after you have created 
and saved a new symbol or footprint, others will be able to find your part. You will be credited 
as a contributor. https://easyeda.com/page/contribute 

 
 

.PDF 

https://easyeda.com/page/contribute


Experiment no:04 
 

Experiment Title:  Version-Control & Member 

Management 
 

 

EasyEDA provides a simple but powerful version control feature. Each version is independent, 
you can edit and save each version. 
When creating a new project, the default name will be set to "master", you can edit the name 
using the "Project Manage - Version" page. 

You can create up to 10 versions for every project. To create a new version, you must first 
delete an older version. 

Create New Version 

Use: Project folder - right-click menu - Version - New Version 

In the new version dialog, you type the version's name and description, and then create it. 

To switch to another version use "Version - Switch Version". 

Switch Version 

Click "Switch", the dialog will list the current version and all the other versions for this project, 
you can select one. 



 

Note: 

Before switching to the other version, you must close the current version. 
You only can open the current version document, if you want to open other's version's 
document, you must switch the version first. 
If you are not sure which version it is, you can check it using "Switch Version" dialog to 
check the "Current Version", or hover the mouse cursor on the project folder. 

 

 

Version Management 

Using "Version Management" will open the "Project Page - Version". 
which will list all versions. You can edit each versions name and description or delete them. 
The current version cannot be deleted. 



 
 
 

Project Member 
 

 

How to share project with selected people. 

Can you share a private project with your partner? Can your partner modify your designs? 

If the answer is yes, you can use Member to do this. 

Right click on the project and you will see the Member on the context menu; clicking on it will 
open the Member webpage. 

 

To share a project with someone, 

1. You need to know the E-mail address they used to create an account with EasyEDA. 

2. The project member is set as "Developer", "Manager", or "Observer". 

After setting up Member and Permissions, your partner will find your project in the Open 
Project when they log in. 

If you partner does not wish to accept the shared project, they can reject it by leaving the 
project when they enter this project "Member" function. 



 

 

Share with Public 
 

 

Sharing your work with others is a big feature of web based EDA tools and EasyEDA is no 
exception in offering great features. 

Did you create a cool project with EasyEDA? Show it off and be super helpful to other EasyEDA 
users, you just need to set your projects to public, so others can explore your circuits. 

All projects in EasyEDA are set to private by default, your private project is not shared with 
anyone. 
To make it public, you should right click and edit your existing project to make it a 
Public project: 

In the Workspace, click the Share icon when the mouse hovers over the project cover, it 
will ask you to confirm. 

 
Or enter project manage page, using "Workspace > Project > Manage > Settings > Basci 

> Project proerty:Public" 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
In the editor, you right-click the project, then click the 
project as public. 

menu after setting the Share 



 
 
 
 

User Preference 
 

 

When EasyEDA shows the login success popup in the bottom right of the window, the user 
management menu will look like this: 

Click on Top Menu - Setting - User Preferences, 
 

Document Recovery Setting: 

Maximum backup level: Every opened document can be saved as a backup, up to this 
number of different revisions. 
Auto backup interval: This is the time interval between auto saves of all your opened 
documents. 

The Document Recovery function you can find at: 



 
 
 
 

  



Experiment no:05 
 

Experiment Title: Shortcut Keys of EasyEDA 
 

 

While using an EDA tool suite, clicking all over the place with a mouse can get very tedious 
and seriously reduces your productivity. Keyboard shortcuts or Hotkeys avoid much of 
that. EasyEDA not only provides many hotkeys, but also every hotkey can be reconfigured to 
your personal preference. 

Under the Setting menu, click the Hotkeys Setting... Menu which will open the Hotkey 
Setting dialog. 

 

 
To change a Hotkey, click anywhere in the row for the hotkey you want to change and then 
press your new key. 

For example, if you want to use 
first row, then press R . 

instead of to rotate selected objects, click on the 

After changing any hotkey, you must click the Save Changes button. 

The docType column describes which type of EasyEDA document each hotkey applies to. 

docType has three types: 

ALL: any document type in EasyEDA. 
SCH: schematic and schematic libs 
PCB: PCB and Footprints. 

The functions of some hotkeys may change between docTypes. For example, the hotkey 
draws an Arc in SCH but draws a circle in PCB. 

A list of all the available default hotkeys is given below. 

All document 

R space 

C 



 

DocType Shortcut Function 

All Space Rotate selected objects 

All Right-Click 
Keep right-click to pan canvas; Open offset dialog when 
select one object 

All Left Scroll Or Move selected left 

All Right Scroll or Move selected right 

All Up Scroll or Move selected up 

All Down Scroll or Move selected down 

All TAB 
Change object's attributes when placing; Open offset 
dialog when selecting an object 

All Esc Cancel current drawing 

All Home setting new canvas origin 

All Delete Delete Selected 

All F1 Open tutorials 

All F11 Full screen at browser 

All A Zoom In 

All Z Zoom Out 

All D Drag 

All K Fit Window 

All R Rotate selected objects 

All X Flip Horizontal(doesn't support footprint) 

All Y Flip Vertical(doesn't support footprint) 

All ALT+F5 Full screen at browser 

All ALT+W Close current tab 

All SHIT+ALT+W Close all tabs 

All CTRL+X Cut 

All CTRL+C Copy 

All CTRL+V Paste 

All CTRL+A Select All 

All CTRL+Z Undo 

All CTRL+Y Redo 



DocType Shortcut Function 

All CTRL+S Save 

All CTRL+F Find Component 

All CTRL+D Design Manager 

All CTRL+Home Open canvas origin setting dialog 

All SHIFT+1 Cycle forward to next open tabbed document 

All SHIFT+2 Cycle backward to next open tabbed document 

All SHIFT+X Cross Probe 

All SHIFT+F Search Library 

All SHIFT+Drag Cursor snap to part's origin 

All SHIFT+ALT+H Align horizontal centers 

All SHIFT+ALT+E Align verticas centers 

All CRTL+SHIFT+L Align left 

All CRTL+SHIFT+R Align right 

All CRTL+SHIFT+O Align top 

All CRTL+SHIFT+B Align bottom 

All CRTL+SHIFT+G Align grid 

All CRTL+SHIFT+H Distribute Horizontally 

All CRTL+SHIFT+E Distribute Vertically 

All CTRL+SHIFT+F Find similar objects 

 
 

Schematic 



DocType Shortcut Function 

Schematic W Draw Wire 

Schematic B Draw Bus 

Schematic U Bus Entry 

Schematic N NetLabel 

Schematic P Place Pin 

Schematic L Draw Polyline 

Schematic O Draw Polygon 

Schematic Q Draw Bezier 

Schematic C Draw Arc 

Schematic S Draw Rect 

Schematic E Draw Ellipse 

Schematic F Freehand Draw 

Schematic T Place Text 

Schematic I Edit Selected Symbol 

Schematic CTRL+Q NetFlag VCC 

Schematic CTRL+G NetFlag GND 

Schematic F8 Run the Document Simulation 

Schematic CTRL+J Open the Simulation Setting 

Schematic CTRL+SHIFT+X Cross Probe and Place 

Schematic SHIFT+T Open symbol wizard 

Schematic ALT+F Open footprint manager 

 

PCB



DocType Shortcut Function 

PCB W Draw Track 

PCB U Draw Arc 

PCB C Draw Circle 

PCB N Draw Dimension 

PCB S Draw Text 

PCB O Draw Connect 

PCB E Draw copperArea 

PCB T 
Change To TopLayer; Change selected part to 
toplayer 

PCB B 
Change To BottomLayer; Change selected part to 
bottomlayer 

PCB 1 Change To Inner1 

PCB 2 Change To Inner2 

PCB 3 Change To Inner3 

PCB 4 Change To Inner4 

PCB P Place Pad 

PCB Q Change canvas unit 

PCB V Place Via 

PCB M Measure 

PCB H 
Highlight Net all the time, press it again cancel 
highlight 

PCB L Change Route Angle 

PCB - 
Decrease Routing Width; Switch to the forward 
signal layer 



DocType Shortcut Function 

PCB + 
Increase Routing Width; Switch to the next signal 
layer 

PCB * Cycle switch to the next signal layer 

PCB Delete 
Delete selected object; Undo the track when 
routing 

PCB ALT-- Decrease Snap Size 

PCB ALT++ Increase Snap Size 

PCB CTRL+R 
Depend on reference point for copy object 
repeatly 

PCB CTRL+L Open layer manager 

PCB CTRL+Q Hide/show network text 

PCB SHIFT+M Remove All Copper Area fill data 

PCB SHIFT+B Rebuild All Copper Area 

PCB SHIFT+D Move Object(s) by reference point 

PCB SHIFT+G Display track length while routing 

PCB SHIFT+W Show favorite track width while routing 

PCB SHIFT+R Change routing conflict 

PCB SHIFT+S Toggle layers which is not active 

PCB SHIFT+Double Click Delete selected track segment 

PCB CTRL+SHIFT+V 
Paste object(s) and keep the prefix, and hide the 
ratline layer 

PCB CTRL+SHIFT+SPACE Change routing angle, same as hotkey L 

PCB CTRL+ALT+L Enable all layers 

Footprint CTRL+SHIFT+ALT+D Open custom data dialog 

 

 
 

  



Experiment no:06 
 

Experiment Title: Basic Skills of EasyEDA 
 

 

To use EasyEDA you need to be familiar with a few basic terms and concepts. The best way to 
learn them is to open up EasyEDA, and create a new schematic: 

File > New > Schematic , and play! 

Saving Your Work Locally 
Although EasyEDA saves all your files on our Server, sometimes you may want to save your 
work locally and EasyEDA does provides a way to do this. 

You can right-click your project folder, and click "Download Project", or export your design as 
EasyEDA source file via "File > EasyEDA Source". 

For more detail you look here: Export EasyEDA Source section. 

To download your project: 
 

 

History Record 

It is easy to use this function, right click on the document for which you need the history as in 
the image below: 

After clicking on the history link, you will get a list of the History as in the image below. 

 

 

 

 

 

 

http://./Export.htm


 

 
Click the History number to open the saved file in the editor, if this is what you need, you can 
save it to your project and delete your bad file. 

Note: 
1. For now, all the History entries are tagged with a number. An upcoming feature will allow 
you to add a custom tag. 
2. Saving your files too frequently will create many History entries and it will become more 
difficult to find the exact one you want. 

Document Recovery 

No operating system, software or network is perfect, so sometimes things go wrong. Having 
your Desktop or web browser freeze or your broadband connection drop, two hours into 
laying out a PCB, could spoil your day. 

However, with EasyEDA, your day will be just fine. 

This is because EasyEDA auto saves and makes backups of all your open files to your 
computer, crash recovery is built into EasyEDA. 

On the top menu, click Menu - Advanced - Document Recovery as below: 
 

Expand the folder to the latest version, Select the file which you would like to recover, then 
click the Recover button; your file will be opened in a new tab, then save this opened file. 

Please note: 
 

EasyEDA saves these crash recovery files on your computer and not on the EasyEDA 
server. Therefore you cannot recover files from a crash on one computer or browser by 
changing to a different computer or browser. 



If you cleaned your browser's cache, the recovery files will disappear. 
If you made a mistake deleting a file and removing the cache, you might be able to find 
your document in the recycle bin: https://easyeda.com/account/user/recycles/personal. 

 
 

Resizing the canvas area 

Hovering the mouse cursor over the areas indicated by the three green ellipses will bring up 
the blue sidebar toggle lines. Clicking on them will toggle the visibility of their associated right 
and left areas to expand the canvas area. The vertical lines can be dragged horizontally to 
resize the panels. 

 

Cursor Style 

Some users do not like the cross cursor, so you can change it to an arrow cursor like in the 
image below. 

Via: Top Menu - View - Cross Cursor 

 

 

 

 

 

 

 

 

 
The difference between these options is shown below: 

https://easyeda.com/account/user/recycles/personal


 
 

Clear and delete 

If you think your schematic or PCB looks terrible, and you want to redraw everything, you can 
do this: 

Top Menu > Edit > Global Delete. 
 

Delete this schematic and create a new one. 

Click one object or CTRL+A, press delete key to remove all objects. 

Left clicking 

Similar to other EDA software: 

Click on an item to select it; 
If over a selected item, click and hold to drag a selected item; 
If not over a selected item, clicking and holding while dragging creates a selection box; 
The selection box, using click and drag to the right, selects everything inside the box; 
The selection box, using click and drag to the left, selects everything inside and 
intersected by the box; 
Double click on a text area to edit the text; 
The exact left click functionality depends on what item is being selected and in what 
Canvas the item exists (Schematic or PCB). 



ESC 

Right clicking 

In EasyEDA, right-clicking opens a context sensitive menu: 

When you are placing a symbol, right-clicking will stop placing and return to select mode. 
This is the same as the ESC key. 
When you are drawing a shape such as a polyline, after a right click, the polyline will be 
stopped at the place where you right click but the mouse will remain as a cross, so you 
can draw another shape. 
To get out of the current active context sensitive command such as placement or drawing 
mode and go back to select mode, just double right click or press ESC (sometimes twice). 

Right-Click and drag Right-clicking and holding the button anywhere in the Schematic, 
Waveform or PCB Canvas while dragging the mouse will move the canvas around within the 
EasyEDA window. Holding the middle button and dragging performs the same operation. 

ESC key 

Pressing the key ends the current drawing action but does not exit the current active 
context sensitive command mode (i.e. it does not return the cursor to select mode). Pressing 
ESC again returns to select mode. 

Select more shapes 

CTRL+Left Clicking on items adds those items to your selection; 
Clicking and holding creates a selection box; 
Creating a selection box, using click and drag to the right, selects everything inside the 
box; 
Creating a selection box, using click and drag to the left, selects everything inside and 
intersected by the box; 

Zoom in and Zoom out 

Using the middle mouse button: 
Roll forward to zoom in; 

Roll back to zoom out; 

Using hotkeys, the default hotkey 

Please note: 

for zoom in, for zoom out. 

Do not scroll your mouse at the same time as pressing the CTRL key when your cursor on the 
top menu, the browsers will zoom the whole website, if you just want to zoom the canvas in 
the EasyEDA window, you need to put your cursor onto the canvas. If the “zoom the whole 
website” happens, just press 

Double clicks 

to reset the browser view zoom. 

Double clicking any text area opens a resizable text box that allows you to edit the text. 

A Z 

Ctrl+0 



 
 

Press the enter key to save your changes. Click outside the box or press ESC to discard your 
changes. 

Pan/Move Canvas 

Right click anywhere in the Schematic, WaveForm or PCB Canvas and Hold down right 
button to drags the canvas around within the EasyEDA window. 
If your canvas is bigger than the EasyEDA window and is showing scroll bars, you can use 
either the scroll bars or the Arrow keys to scroll the canvas to pan. 
When drawing a wire, a graphic line or shape that you wish to extend beyond the edge of 
the EasyEDA window holding down the left mouse button after starting the line will pan 
the canvas to keep the drawn item inside the window. 

Tip: 
If you use Chrome, and cursor is in the canvas while pressing CTRL or ALT key and rolling your 
mouse, the canvas will move vertically, and when pressing SHIFT and rolling your mouse, the 
canvas will move horizontally. 

Rotate 

After selecting one or more items, you can rotate the selected items using: 

Top Menu > Format > Rotate or by pressing the default rotate hotkey: ‘Space’. 



 

When in PCB view mode you can click the footprint and change its rotation in the right 
property panel. 

Please note: 
Rotating a multiple selection rotates each item about its own symbol origin. It does not rotate 
the items about the centroid of the group of items. 

Flip 

To place a Q2 as shown in the schematic below you need to Flip the item. Via: Top menu - 
Format - Flip. 

 

You can Flip one or more selected items using: 

Rotate and Flip > Flip Horizontal or Flip Vertical from the toolbar, 

or by pressing the default flip hotkeys: to Flip Horizontal, to Flip Vertical. 

Notice: Footprint does not support the flip command. 

Align 

X Y 



EasyEDA provides many align option features, you can align your symbols or footprints very 
easily using: Top menu - Format - Align. There are also icons on the toolbar for this. 

 

Bring to Front and Send to Back 

In the image below, both the rectangle and the ellipse are filled. Use: Top menu - Format - 
Bring/Send to Front/Back. 

If you draw an ellipse before drawing a rectangle, the rectangle will overlap and therefore hide 
the ellipse. To reveal the ellipse, select the rectangle and then use the Bring and Send 
function, as shown: 



 
 
 

Multiple Windows 

Since v6.4.0, EasyEDA supports multiple windows design. 

How do it works? 

1. Open schematic and PCB 

2. Right-click the schematic or PCB tab, click "Open in New Window" 

 

 

 

 
 

3. This will open the document in a new window, then you can do the cross probe: Click the 
component, pads, click the Design Manager list, the "Cross Probe and Place" also works. 

Documents Tab Switch 

It is easy to modify the tab positions of your documents. 

Simply drag the tab location, or use the hotkeys SHIFT+1 and SHIFT+2 
 



Experiment no: 07 
 

Experiment Title: Basics of Schematics 
 

 

During this tutorial we will create a simple Schematic design to guide you in using EasyEDA 
Schematic capture. 

You can find the canvas Properties setting by clicking on any the blank space in the canvas. 
 

As described earlier, background and grid colours and the style, size, visibility and snap 

attributes of the grid can all be configured. 

The canvas area can be set directly by the Width and Height or by using the available preset 
frame sizes. 

Grid: 

Visible Grid : Yes or No 
Grid Color: Any valid colour 
Grid Style: Line or Dot 
Grid Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10, 20, 
100. the unit is pixel. 
Grid (and background) colour can be set directly by entering the hexadecimal value of 
the colour you want or by clicking on a colour in the palette that opens when you click on 
the colour value box: 



ALT 

 
 

Snap: 

Snap: Yes or No. Pressing this key toggles switching snap to grid on and off. 
Snap Size: To ensure proper alignment of all EasyEDA parts, it is advisable to set in 10, 
20, 100 but any valid number can work, such as 1, 5, 10. 

It is strongly recommended that you keep Snap = Yes all the time. Once items are placed off- 
grid it can be very difficult to reset them back onto the grid. Off-grid placement can result in 
wires looking as though they are joined when in fact they are not and so causing netlisting 
errors that can be hard to track down. 

If you need to draw detailed parts of new symbols or footprints that need to go between grid 
points, try to reduce the grid spacing to draw these elements and then reset the grid back to 
your chosen default value as soon as you have completed that part of the drawing. Setting 
Snap=No should only really be used as a last resort. 

ALT Sanp: Snap size when pressing the key. 

 
 
 

Wiring Tools 
 

 

 
If you have hidden your tools , you can open them from here: 
Top toolbar Top Meun > View > Wiring Tools... 



W 

 
 

 

Note: All of the commands in Wiring Tools are electronics related. Don't use a wire when you 
just need to draw a line, shape or an arrow: use Drawing Tools instead. 

 
 

Wire 

There are three ways to enter the wire mode in EasyEDA. 
 

1. Click the Wire button from the Wiring Tools palette. 

2. Press the hotkey. 
3. Click on the end of a component pin (where the grey pin dot appears if you select the 

component): 



 
 

EasyEDA automatically enters Wire mode. 

Here is a screenshot of the Astable Multivibrator LED project schematic after wiring: 
 

Moving Components and Wires: 

If you place a component, such as a resistor, on top of a wire then the wire breaks and 
reconnects to the ends of the component. 

When moving selected components using the mouse, they will drag attached wires with them 
(“rubber band”) to some extent but please be aware that the rubber banding feature has 
some limitations. When moving selected components most wire will move vertically and 
horizontally. Using the arrow keys will not rubber band. Selected wires do not rubber band. 

 



A selected wire can be moved directly by clicking on it using the mouse or by the arrow keys. 
If a wire is selected by clicking on it using the mouse then green grab handles will appear at 
the ends and vertices. 

Auto adjust connection 

If you put a resistor or capacitor on a wire, the wire will auto connect the pins as below: 
 

When you want to wiring a series of resistors which are in a row, you can just wire through 
them, and then you will find they all be connected. 

 

Wire Node 

When you click on the wire, you can see the nodes on the wire, where the white is the virtual 
node, the red is the real node, drag the virtual node to generate the real node, and right- 
delete the line segment is to delete the line segment between the real nodes. 

 



 
 

Bus 

When you design a professional schematic, perhaps it will use a lot of wires. If you wiring one 
by one, much time would be wasted, and then you need to use Bus . 

 

 



Bus 

Bus Entry 

If you decide to wire with 
such as in the above image. 

 
, the 

 
must connect to Bus and other nets with wires. 

 

 
 

The "Bus" and "Bus Entry" just for the indication, because when you place Bus and Bus Entry, 
you have to place the netlabel on the Bus Entry dot point. 

Net Label 

NetLabel can be used to give your wires names to help you find them and identify any 
misconnections. You can find the NetLabel from the Wiring Tools palette or by using the 

hotkey. When selecting the netlabel, you will find its attributes in the right hand 

Properties panel: 

You can change its name and colour. If you only want to change its name, it may be easier to 
just double click the netlabel. 

Multi-NetLabels in One Wire 

EasyEDA support mutil-netlabel in one wire now. 

When you convert the schematic to the PCB, the editor will choose the first netlabel you 
placed as the net name for this wire, as below NETLABEL1. 

Bus Entry 

N 



 
 

Convert to PCB: 

 

 

 

 

 

 

 

 

 

 
As above image, when you click anyone netlabel's name in the design manager, the wire will 
be highlighted. 

 



And check the bottom right corner, you will see a warning: 

 

 

 

 

 
Notice： 

If wire 1 has 3 netlabels A B and C, and wire 2 has netlabel A, then wire 1 and wire 2 are 
the same net. 
Netlabel/Netflag/Netport/volprobe only support English characters and letters, and 
Arabic numerals. 
If a part prefix is P1, which has two pins, it will have two nets "P1_1" and "P1_2" by 
default, if you place a netlabel named P1_1 at other wire which is not connect with P1 
pin1, the default "P1_1" will change to "P1_1(1)" for avoid the wrong connection with 
netlabel "P1_1". 

Net Flag 

NetFlag is the same as NetLabel, you can find the NetFlag from the Wiring Tools palette or 

using the hotkeys for GND or for VCC. You can also change its name, for 

example from +5V to VDD: 
 

When appear two and more Netflag or Netlabels which are the same name, they will 
connected with each other. 

Ctrl+G Ctrl+Q 



Net Port 

 

Wiring Tools palette provides NetFlag: Digital GND, Analog GND, VCC and +5V for your 
convenience. 

Net Port 

At EasyEDA, Net Port works like Net Label, it doesn't differentiate the input and output net 

port. When you don't want to route too many wires, how about trying : 
 

 

 

It will make your schematic look more clean, and you just need to set each Net Port a net 
name. 



 
 

No Connect Flag 

You can find the 

 
via wiring tool, 

 

 
 

In the below schematic, if you don't add a 
collection of the design manager. 

NO Connect Flag , there is an error flag in the nets 

 

 
 

And will show the warning: 

NO Connect Flag 



After adding a NO Connect Flag , and then refresh the Nets folder, the error disappears. 
 

 

Note: 

Voltage Probe 

only works on the symbol's pin directly. 

 

 

EasyEDA provides a simulation feature for the schematic. After the simulation is running, you 
will see the waveform where you placed the voltage probes in the circuit. 

 

 

For more detail about the simulation, please check the Simulation section. 

Pin 

When you create a new symbol in schematic and schematic lib, you must use 
pins for the new symbol, otherwise your symbol can't be wired with wires. 

 

 
to create 

NO Connect Flag 

Pin 

https://docs.easyeda.com/en/Simulation/Headings/index.html


 

For more information please refer to the Symbol Library - Create Symbol section. 

Group/Ungroup Symbol 

On the Wiring Tools palette there is the Group/Ungroup Symbol… button. 
 

Just like the Symbol Wizard, this tool is also for you to quickly create schematic library 
symbols. 

Here's how. 

Place Pins and other objects such as rectangle 



Select them, and click the "Group/Ungroup Symbol" icon 

 

 

 

 

 

 

 
Type the prefix and name, press OK, done. A part is created. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

So what does Ungroup do? Try selecting a symbol and then click the Group/ungroup 
command to see what happens! 

Note: 

The symbol you created in the schematic will not be saved in the personal libraries, if you 
want to use it repeatly, please create a Symbol via: Top Menu - File - New - Symbol. 

 

 

  



Experiment no: 08 
 

Experiment Title: Drawing Tools of EasyEDA 
Sheet Setting 

It is now possible to add design notes to the frame and the frame selection, for example A4, 
which can assist in aligning and improve the look of printed schematics and PCB designs. 

Click the frame/drawing/document button like in the image below： 
 

And you can edit the blue text when you've selected the text attributes or double clicked it. 

The bottom right zone can be selected and dragged or the frame can be dragged and 
deleted. 

When you've selected the bottom right zone, you can edit the sheet attributes: 
 

Custom Sheet 

EasyEDA supports the schematic diagram drawing frame required by custom. At present, 
custom drawings need to be placed manually, and automatic reference of custom drawings is 
not supported when creating new schematic diagram. 

How to create: 



1. Click the "Sheet Setting" button at "Drawing Tool". 

 

 

 

 

 
2. Click "Add Custom" button. 

 

 

 

 

 

 
 

3. It will create a new symbol editor, you can edit the table by line as you want, as below: 

 

 

 

 

 

 

 
4. Select the outline, you can edit its size. 



5. Save it. You can place it in schematic such as a part at "Library". 

 

Line 

In the Schematic editor, you can draw a line with any direction. You can change its attribute as 
in the image below: 

 

Bezier 

With this tool, you can draw a pretty cool pattern. 
 

Arc 



You can draw the arc of any shape. 

 

 

 

 

 

 

 

 

 

 

 
Arrow Head 

You can add arrow head to marking text or important part. 

 

 

 

 

 

 

 

 
 

Text 

Text attributes provide many parameters for setting: 

Text: You can change text in inner box or double click the text. For every new text, the 
default text is Text . 

-Color: Defines text color. 
-Font-family: It provides 12 fonts for choosing. 
-Font-Size: Defines Text size. 
-Font-weight: Defines Text weight. 
-Font-Style: It contains (auto), normal, italic. 

-Text type: types include comment and spice. 

The editor will remember your last text parameters. 



 
 
 

Image 

When you select Image from the Drawing Tools palette, an image place holder will be inserted 
into the canvas: 

 

Select the place holder, so you can see the image's attributes in the right hand Properties 
panel: 

 

Set the URL of your image. For example, setting the URL to: 

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-  
555_Pinout.svg.png 

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png
http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png


will make your image look like this: 
 

Please note: at present, EasyEDA cannot host images, so you need to upload your images to 
an image sharing site. 

Drag 

If you want to move some kind of parts and wires, you can use drag, hotkey D. 
Or you can select the parts and wires area firstly and move them. 

 

Canvas Origin 

Canvas origin default is set at left top corner of the schematic sheet, but you can set it where 
you want via Canvas Origin. 

For another way to set canvas origin, you can try Top Menu> Place > Canvas Origin. 
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Experiment no: 09 
Experiment Title: Library Management in EasyEDA 

 

 

EELib 

That contains ready made symbols for a wide range of components and which can be 
simulated. 

 

Many of these components have optional US and EU style symbols, we split them, so you can 
select those you like. Click on the drop down list or right click to popup the context menu, it 
contains many footprints or parameters. EasyEDA will remember your choices for the next 
time. 

Don't forget to use Filter to locate a component fastly. For example, you just need to type 
to find all of resistors: 

 

 
Library 



EasyEDA provide a lot of libraries, you can find them at "Left-hand Panel - Library", hotkey 
"SHIFT+F", at here you can search library from LCSC, system, user contributed etc. 

 

Type 

Symbol: Schematic symbols 
Spice Symbol: Symbols for spice simlation 
Footprint: PCB footprints, PCB pattern. 
SCH Modules: Schematic modules, a part of the circuit design. It can not assign the PCB 
module, doesn't like the schematic Symbol can assign the footprint . when it be placed 
on the schematic, it will be separated. 
PCB Modules: As like as Schematic modules. 

3D Model: It is bind with footprint via "3D Model Manager". 

Classes 

Work Space: It include your personal parts and your teams' parts. 
LCSC: EasyEDA online part store LCSC.com parts(Officail Parts). It will add new libraries 
everyday 
LCSC Assembled: JLCPCB Assembled parts. All JLCPCB assembly parts will contain a SMT 
icon, that means this part can be JLCPCB assemble. 
System: EasyEDA system parts, it comes from open source libraries, such as Kicad 
libraries, company public libraries, user contributions. 
Follow: If you follow a user at EasyEDA(You can follow a user at him/her user page), you 
can view and use his/her libraries. 
User Contributed: When you searching a part, maybe you can find it at this class. At 
EasyEDA, all libraries are public. the detail you can refer at: Contribute 

We add an "JLCPCB Assembled" Components option of the Parts, It's easy to choose which 
component can be assembled by JLCPCB. Yes, JLCPCB will provide the assembly service. the 
more information please refer at: How to order a SMT order 

 
Search Engine - EasyEDA 

Simply type your part number or symbol's name to Search. before searching, you must choose 
the "Type" first. 

https://lcsc.com/
https://easyeda.com/page/contribute
https://jlcpcb.com/smt-assembly


and then click the "Table of contents" to open the categories list to choose your components. 

From there you can scroll up and down to browse parts from each category. 

If you know the component's name 
Suppose you want to find the MAX232 (which converts signals from an RS-232 serial 
port to signals suitable for use in TTL compatible digital logic circuits). Simply type 
Max232 into the Search box and press Enter: 

 

 

 

 

 

 

 

 

 

 

 

 

 

If you don't know the component's name 
For example, you want to find a resistor which value is 1kohm, footprint is 0603, at 
Libraries you can follow below steps: 

1. Choose the library type 

2. Typing the keyword such as 

3. Click the search button 
4. Select the class you which is wanted of the result 

5. If you don't need the search you need to remove all the search keywords 

 

 

 

 

 

 

 

 

 
 

Search Engine - LCSC Electronics 

When you want to find some parts by clearly parameter, you should try "Search Engine - LCSC 
Electronics", it all most same as LCSC.com. 

1k 0603 

http://www.google.com/url?q=http%3A%2F%2Fen.wikipedia.org%2Fwiki%2FRS-232&sa=D&sntz=1&usg=AFQjCNFt_BArd4HZuR1QqCUxvKGW3ki3UA
http://www.google.com/url?q=http%3A%2F%2Fen.wikipedia.org%2Fwiki%2FTransistor-transistor_logic&sa=D&sntz=1&usg=AFQjCNFoI3eJYGc8PWqUdnfqHGREfTZccw


 
 

When you find out part, and you can place into the schematic: 
 

Notice: 

The subpart can not be preview at Preview dialog window, if you find out this, you need 
to change to "Search Engine - EasyEDA" to place this part. 



 
 

Max and Min mode 

If you want to place without close the "Library" dialog, you can change dialog mode to Min 
mode, just click the Min button at the top-right corner. 

 

 
Operations 

When you hover the mouse over the picture of the Schematic symbol or PCB footprint, you 
will find a toolbar with "Edit", "Place", "More" buttons. 

Place: 

For parts you use infrequently, you don't need to Favorite them; just Place it into your canvas 
directly. Or you can double click the library to place. 

Note: 

EasyEDA supports multi-documents so please make sure that you are placing the part 
into the right (active) document. The active document is the one with the highlighted tab. 
You can't place a Schematic symbol into a PCB file, or a PCB Footprint into a schematic. 
EasyEDA will try the best to make sure the library is correct, but it still has incorrect parts, 
if you find any incorrect parts please let us known. suggested order a sample first before 



 
Edit: 

ordering a big order. 

If you want to create your own version of a symbol or footprint then you can open an existing 
part from the library to use as a template, edit it and then save it to your local Work Space 
library in Library of the Navigation Panel. 

More: 

We can't promise that every component in the library is free of errors so please check all 
symbols and footprints carefully before you commit to a PCB order. 

If you do find a mistake in a component, please use the Report Error , so that we can fix it. 

Components with sub parts (multi-device footprints). 

When you find a component with sub-parts, you can't Place or Edit it, but you can Favorite 
and Clone it as your own part, which you can then edit. 

 

Right-Click 

When you right-click the part list, you can edit its tags, add favorite etc. 

 

 

 

 

 

 

 

 

 
Preview Image 

Every library when you click, you can check its preview image, such as symbol, footprint, 
production picture. Click the the image you can open it quickly. 



 

 

Placing Components 

Find the component which you plan to place to your schematic at "Libraries", then move your 
mouse to the canvas and left click. If you want to add more, just left click again. To end the 
current sequence of placements, right click once or press ESC . 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

Don't try to Drag and Drop a component to the canvas EasyEDA team thinks that Click-Click 
to place components will be easier to use than a Click-Drag mode. 

 

Multi-part Components 

The number of pins on some components can be quite large. That's why it's easier to divide 
such a component into several parts or functional blocks, it calls multi-parts or subparts. 



As a simple example, there are six gates in the 74HC04 Hex Inverter component. To avoid 
clutter in the schematic, GND and VCC pins of such components are usually served by a 
separate part of the component. This is really convenient as it doesn't interfere the working 
process with logical parts. The NetLabel names of VCC and GND Pin are usually hidden. 

When placing the 74HC04 on a schematic, it will look like the screenshot below. 

Note: The component Prefix will be in form of: U?.1, U?.2 etc. 
 

If you click the father-part and place on the schematic, the remaining subparts will be placing 
one by one, if you click the one of the subpart, you will placing U1.1, U2.1, U3.1 etc. 

How to create multi-part(subpart) please refer Create Symbol 

Schematic Symbol Wizard 

How many times have you hit a schematic capture roadblock because you couldn't find a 
component symbol? 

Well, in EasyEDA that would be never because the Schematic Symbol Wizard provides a quick 
and easy way to create a general schematic library symbol. 

Via: Top Menu > Tools > Symbol Wizard in a new schematic symbol or sheet document. 
 

 
The professional function please refer at Schematic Symbol Wizard 

https://docs.easyeda.com/en/SchematicLib/SchLib-Create/index.html
https://docs.easyeda.com/en/SchematicLib/SchLib-Wizard/index.html


 

 
 

Experiment no: 10 
Experiment Title: Component Management in 

EasyEDA 
 

 

Component Attributes 

After selecting a component, you can find the component's attributes in the right hand 
Properties panel. 

 

1. Component Attributes: 



You can change the Prefix and Name here，And make them visible or invisible. 
If you want edit this component, you can click Edit Symbol. 

 

If the component's property "Convert to PCB" is set as "No", it will not appear at footprint 
manager. 

2. Custom Attributes: 

You can change component's supplier, change footprint, and add new parameter. 

 

Define BOM Parameters 
After selected a schematic symbol, you can add a parameter, and you can mark it as In BOM , 
when you export a BOM file, you can find this parameter in CSV file. 

 

 

Modify Symbol Pinmap Information 

When you select a component, for opening the Modify symbol information dialog, you can 
do: 



I Or press the hotkey; 
Or click the Edit Symbol on the Parts Attributes on the left panel. 
Or click the Symbol and right-click, choose the "Edit Symbol" menu. 

Using this dialog you can edit the pin names and numbers, for example, to suit a different 
footprint or device variant. You can also enter a Spice Prefix and swap the spice Pin order to 
make your symbol usable in simulation. 

 

 

More detailed description of PCB and Spice Prefixes and pin numbers at next section. 

Prefixes and Pin Numbers 

Device and subcircuit (or hierarchical block) symbols created for use in schematics that are 
intended to be run as spice simulations, in addition to having a PCB Prefix that is used for the 
reference designator in the schematic, also have a Spice Prefix. They also have two sets of pin 
numbers: PCB pins and Spice pins. 

PCB Prefix and Spice Prefix 

For more information please refer at Simulation: Schematic symbols: prefixes and pin numbers 

 

 

 
 

Component Adjust 
 

 

 

Adjusting Components 

About adjusting components you can: 

1. Move components with your mouse 

2. Move components with the arrow keys. 

3. Find components with the Design Manager via the 

 

 

 
hotkey: select the component 

in the Design Manager to pan it to the centre of the canvas and then move it with your 
mouse. 

CTRL+D 

https://docs.easyeda.com/en/Simulation/Chapter15-Schematic-symbols-prefixes-and-pin-numbers/index.html


4. Align the components: 
 

 
Rotating the Prefix and Value (Name) of components 

The default Prefix and Value (or name) of EasyEDA components are horizontal. To change 
them to vertical, Left click the prefix or value and when it is highlighted in red color, then 
press the rotation hotkey Space and you're done. 

 
 
 

Components Prefixes 
 

 

Prefix Start 

In EasyEDA, at the first new schematic the prefix will start as U1/R1..etc, and EasyEDA support 
global unique prefix at multi-sheet now. 

Prefix Conflict Error 

Sometimes, if you save a sheet to another project, when you convert a project to PCB, open 
the Design manager or run a simulation, you will get a Prefix Conflict error message. 



 
 

In this schematic, you will find two components with the R4 reference designator, so you just 
need to change one to Rx where x is a unique number in that schematic. 

It may be tempting to backup a schematic into the same project as the original, however, if an 
attempt is then made to do Convert Project to PCB, you will get the Prefix Conflict error for 
every component. 

 

In the above image, you can find the two identical copies of the same schematic, which when 
you Convert Project to PCB, EasyEDA will try to merge into a single schematic, so every item 
will have 2 copies. 
To fix this, you just have to create a backup project and remove or better still save backup 
copies of your schematics to that project. 

Annotate 



DATA0 

DATA0 

After creating a schematic, it is quite likely that you have component Prefixes (reference 
designators) that are in no particular order on the canvas. You may also have duplicates. You 
can automatically renumber/reset all the components' prefix by using the Annotate function. 

Via: Top Menu > Edit > Annotate 
 

Various Annotate possibilities are available: 

Re-annotate all: resets all existing annotation and then annotates all components again 
from scratch; 
Keep existing annotation: annotates new components only (i.e. those whose reference 
designator finishes with ? like R? or U?). 
Direction: Rows annotates across the schematic in a raster pattern from top left to 
bottom right; 
Cols annotates down the schematic in a raster pattern from top left to bottom right. 
Annotate: applies the selected annotation actions. 
Reset: if you want to reset all the reference designators to end with '?', just click 
the Reset button. After that, R1 will be R?, U1 will be U? etc. 

Note: 

Reset does not reset annotation back to where it was before pressing the 
Annotate button. 
Annotation cannot be undone! if you do not accept the result: close all of the affected 
schematics without saving. If you do accept the result: make sure you save all of the 
affected schematics. 

 
 
 

Multi-Sheet 
 

 

EasyEDA does not support true hierarchical designs but it does support multi-sheet designs. 

You can put several schematics in one project with connections between made 

by NetLabels/netPorts. All nets in EasyEDA are global so if you create a netlabel in 
sheet A and then create a netlabel 
same project, they will be connected. 

in sheet B, when sheet A and sheet B are in the 



 
 

Multi-sheet designs(equivalent to a circuit spread over several pieces of paper), all 
schematics under the same project will be merged into one when be converted to PCB 
connecting in Netlabel, Netflag, Netport. 

 

 



CTRL+D 

You can click the Sheet tabs on the left-down corner to switch the Sheets, and right-click the 
sheet tab you can "Save as", check "Histories record", "Move Forward/Backward","Rename" 
and "Delete" the sheet. 

 

If you want to arrangement the sheets order, you click the menu of the sheet icon: Move 
Forward/Move Backward. 

 

Note: 
EasyEDA support global unique prefixes, when you place components in different sheet, the 
editor will auto annotate the prefix. If you save as a sheet to another project, please make all 
of the prefixes unique, if the Sheet A has a R1, and the Sheet B has a R1, then you will get a 
Prefix Conflict Error. 

 
 
 

Design Manager 
 

 

With large schematics it can be hard to find the components quickly. Sometimes, you may 
make a mistake such as wiring to a wrong component pin. So you need a tool to help you out. 
Design Manager is just the tool. 

Just press the hotkey to open the Design Manager. 

or click it via on the left navigation panel: 



 

You can click the jump icon to goto the folder quickly. 
 

Filter: You can find your components or net name easily: for example, if you want to find 
all capacitances, you just need to type C ; 

Components: Lists all the components in this schematic. Clicking on a Component item 
highlights that component and pans it to the center of the window. 

 



Nets: Lists all the nets in this schematic. A net must connect at least two Pins, or the net 
name will be marked as a red error. When click the net name, the canvas wire will 
highlight and being large, when you click the empty space to unhighlight: 

 
When you click the net name, you will see the tip at the bottom-left corner. 

Net warning: It will show a prompt exclamation point icon. 

When multiple netlabels on one wire, please check whether if it is correct or just 
connected by mistake. You need to click this net and find it out. If your netflag 
or netlabel only connect one pin, it will show warning. 

The part's pin doesn't place the netlabel, or doesn't connect other pins, or 
doesn't place No Connect Flag. A completed net must connects two and more 
pins, so that, you need to modify your net connection. If you don't need to use 
this pin, please place a No Connect Flag on the pin. 

 
Net error: Prompts a red error icon. 



When Netlabel haven't connected any pins. 

 

 

 

 

 

 

 
Net good: Prompt text small icon. The completed net should connect two pins and 
more. 

When the net is completed. 

 

 

 

 

 

 

 

 
 

Net Pins/Parts Pins: Lists all the pins of the selected net name or components. 
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Experiment no: 11 
Experiment Title: Footprint Management in EasyEDA 

 

 

Introduction 

Want to batch modify components? Can't identify the corresponding relationship between 
component pins and footprint pins? Don't worry, EasyEDA can do this. 

There are two ways to open the footprint manager: 

Click top menu, via: Top Menu - Tools - Footprint Manager 
 

Click the footprint input box of custom attributes when you've selected a component: 

 

 

 

 

 

 

 

 

 

 

 

 

 
1. Footprint manager will check your parts footprint correct or not automatically when open it. 

If the part without the footprint or this footprint doesn't exist in EasyEDA Libraries, or if the 
part's Pins doesn't correspond the footprint's Pads correctly, the footprint manager will show 
the red background alert. 

For example, If your part D1 has 2 pins, 

pin numbers are 
pin names are 

and 2 , 
and C , 



A 

but you assigned a footprint has 2 pads, 

pad number are and C , 

but the part's pin number doesn't match the pad number, so the the footprint manager will 
alert red background: 

 

In order to solve this: 

method 1: change part's pin number from 1 and 2 to A and C. 
method 2: change footprint's pad number as 1 and 2. That needs the footprint is created 
by you. And you can't change the Pad number in footprint manager, you need to find out 
the footprint at "Library > Footprints > Work Space", and then edit it. 

method 3: find an other footprint and update. 

2. In the preview area, you can zoom in, zoom out and pan with mouse scroll button. 

https://docs.easyeda.com/en/PCB/PCB-Tools/index.html#Pad
https://docs.easyeda.com/en/Schematic/Component-Attributes/index.html#Modify-Symbol-Pinmap-Information


Component PIN Information: And you can modify component's pin map information in 
here. 

PCB PAD Information: 

Pad Number: You can check the footprint's pad number, but you can't modify it. 
when you select the component on the left side, it shows component's footprint pad 
number, if you selected a footprint which is searched or selected from the classes, it 
will show the selected footprint's pad number. 
Pad Size: You can check the footprint's pads size and distance, it same as "Check 
Dimension" tool of footprint editor. Click the preview area unit text to change size 
unit. 

Update footprint 

If you want to change the footprint, for example, select a component such as Q1, from TO- 
92 TO TO-220, you just need to click in the footprint input box. EasyEDA will popup the 
footprint manager dialog. You can follow the instructions. 

Type TO-220 into the search box and search, Or change to Select tab, 
Select the classes you want and select TO-220 footprint, 
Verify it in the preview box, 
then press the Update button. 

After that you will find you have changed the footprint to TO-220. 

Note: 

To ensure that you use a footprint type that is already in the EasyEDA library, it is 
recommended that you use this technique to change component footprints rather than 
just typing a footprint name directly into the footprint text input box.because of the 
footprint manager will add the footprint's global unique ID into the schematic when the 
footprint updating. 

 
When you select a subpart, the others subparts will be selected too, so they will update 
the footprint together. 
If the part's property "Convert to PCB" is set as "No", it will not appear at footprint 
manager. 



CTRL + click SHIFT + select 

(or Ctrl+F ) 

Update in Batch 

If you want to batch modify components' footprints, 

In the footprint manager dialog, you can press or to 

select the components, and then select the footprint to update. 
In schematic canvas, you can frame select the commponents as you want, and then click 
the "footprint" attribute input box at the right-hand property panel. 

To use your own footprints, you can select Work Space under the Select tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Find Similar Objects 
 

 

Find Components in the Schematic 

Finding individual components in a dense schematic can be very time consuming. EasyEDA 
has an easy way to find and jump to components: 

Top Menu> Edit > Find… 
 

 

 

Note: You have to click OK?in this dialog or use the Enter key. 



This feature will find, highlight and center in the window, parts by their Prefix (or reference 
designator). However, it cannot be used to find net names or other text in a schematic. 

This is where the Design Manager comes in. the more information please refer Design 
Manager chapter. 

Find Similar Objects 

EasyEDA provide a powerful find similar tool, you can find what you want very easily. 
Via Top Menu > Edit > Find Similar Objects… 

 

Kind: Select the object what you want to find. 
Range: This option only for the schematic, you can find the object for current sheet or all 
sheets. 
Find Parameters: Any: Find any objects; Same: Only find the object which attribute same as 
this attribute. Different: Find the object which attribute is different than this attribute. 



The input box support the Js Regular Expression, you can type 
want, such as find all prefix which are including "R": 

to find what you 

 

 
 

After click the "Find" button, all the siutable objects will be seleted, and the right-hand panel 
will show all the attributes, the different attributes will show as the <...> , you can change the 
attributes directly, and they will apply to all selected objects. 

The find similar objects only support to find a part of custom attributes. Such as footprint, 
suppiler etc. 

 

 

  

/keyword/ 



Experiment no: 12 
Experiment Title: Convert Schematics to PCB in 

EasyEDA 
 

 

Convert to PCB 

Most of the time, schematics are created with the aim of producing a PCB. So how do 
you convert your schematic to a PCB in EasyEDA? You just need to to click the PCB icon on the 
toolbar with the title Convert to PCB. 

 

Note: 

Before converting, you need to use the Design Manager and Footprint Manager to check 
all the components, nets(connection) and footprints to ensure no errors exist. 



Footprints Verification 

After clicking the Convert to PCB button, if the project has errors the following dialog will 
open: 

 

The row in red indicates that EasyEDA can't find a PCB footprint matching the footprint that 
the schematic symbol is calling for. 

This could be because you have made an error entering the footprint attribute in the symbol's 
Properties or maybe you haven't yet created a PCB footprint for the footprint that your 
symbol is calling for. 

In this case the footprint should have been AXIAL-0.3 but instead it is empty. To correct it you 
can click on the row and update the footprint AXIAL-0.3 for it at the footprint manager. 

After making any necessary corrections, click the Convert to PCB button and EasyEDA will 
automatically load all the PCB footprints into the PCB editor as shown in the image below. 



Convert to PCB... 

Update PCB 

 
 

This shows the footprints placed in arbitrary positions with the connections between them 
shown as blue Rat lines. 

Invalid footprint 

The footprint's PAD number is different from the symbol's PIN number, e.g. the diode 
footprint's PAD numbers are A,C but the symbol's PIN numbers are 1,2. You just need to 
change one to fit the other. It is case sensitive! 

 
the changing method please refer the Schematic - Footprint Manager section. 

Update PCB 

Converting a schematic to PCB can be done using the 
modifications to the schematic, by using the 

, but if you do 
button you can immediately be 

passed forward to update the selected PCB without having the PCB editor window already 
open or without creating a new PCB file. 

 

or you can use "Top Menu - Design - Import Changes" at PCB editor. 



 

 

Cross Probe 
 

 

This tool is used to cross probe from chosen objects on the current schematic to its 
corresponding counterparts in the PCB, or from PCB Footprints to corresponding counterparts 
in the schematic. 

 

Since v6.4.0, EasyEDA supports multiple windows design to cross probe. 

How do it works? 

1. Open schematic and PCB 

2. Right-click the schematic or PCB tab, click "Open in New Window" 

 

 

 

 
 

3. It will open this document in new window, then you can do the cross probe: Click the 
component, click the Design Manager list, the "Cross Probe and Place" works too. 

Note: 

You need to open PCB first before using cross probe in the schematic. And don't forget 
to use the hotkey SHIFT+X . 
After converting the schematic to PCB, for using this function please save the PCB first. 
If your project has many PCBs, when you use the cross probe please open the PCB what 
you need manually. 

 

 

 
 

Cross Probe And Place 
 

 

If your schematic have a lot of components, it will be difficult to layout the PCB , so EasyEDA 
provides a powerful function "Cross Probe And Place". 

Top Menu> Tools > Cross Probe And Place 



 

Cross Probe And Place will make the footprints' location match the schematic's parts' location 
as much as it possibly can. 

How to use: 

Convert the schematic to PCB first, and save at current project. 
Frame select the components area by mouse in the schematic, and then click the "Cross 
Probe And Place", hotkey "CTRL + SHIFT + X". 
The editor will switch to the PCB, and choose the footprints as you selected for waiting 
for placing. 
Right click to place, and the mouse will keep the drag status, its easy for adjusting the 
footprints' location. 

 

Notice: 

You need to open PCB first before using this function in the schematic 

 
 
 

Update Components from Library 
 

 

If you want to update the component at schematic when you update the parts at Library, can 
use this feature. 

Via: Top menu - Design - Update Components from Library 
 



Click the menu you will see the update dialog, you can preview the current components and 
compare with latest version. 

 

You can setting check the component latest version when open the schematic at bottom 
option. 

Before update components, please check the parts shape, pin number, footprint carefully. 

PCB has this feature too at Design menu, you can update footprint from Library. 

Notice： 
Since v6.4.20.7, while placing the component at the schematic, that will keep the symbol and 
footprint corresponding at that time, no matter you update your footprint or not, it will not 
impact by latest footprint as previous editor version. when you import changes, the footprint 
will use at that time version, will not use the latest footprint version, if you want to use the 
latest footprint, you need to update component first. 

If you want to update single one compoennt, you can right-click it and update 



 
 
 
 

Reset Component ID 
 

 

This function resets the ID of the component. 

Before V6.4.7, EasyEDA was created by using component prefix to correspond schematic 
components to PCB components. This method would lead to the situation that after the 
schematic component was modified with component prefix, the old method would deleted 
and add new component when imported and updated into PCB, which would affect the 
original layout of components. 
Since V6.4.7, the component ID is used for matching associations, so old files or imported 
third party EDA files can use this feature to reset the component ID so that the two IDs match. 

Via: Top Menu - Design - Reset Component ID 
 

Notice： 

1. Make sure that the schematic diagram and the component prefix of the PCB match. 
The reset ID is reset based on the component prefix. 



2. It is necessary to reset the component ID on both schematic diagram and PCB so 
that the component ID on both sides can match one by one. 

3. For schematic diagram with subparts, it is necessary to change the component prefix 
of the subparts of PCB pair to U1.1 or other subparts prefixes before resets the ID, 
otherwise this component will still be deleted and replaced with a new one. 
Subsequent releases will solve this issue. 

 

 

Global Delete 
 

 

If you feel your schematic or PCB is mess up, need delete objects in batch, you can: 

Top Menu > Edit > Clear All，or CTRL + A select all and then press Delete key. 

Delete the document and create a new one. 



Using Top Menu > Edit > Global Delete, just delete what you want. 

 
 

 

 

Schematic Modules 
 

 

Copying codes is an easy job for coders, now copying and reusing a schematic or PCB is easy. 
Take a power supply unit for example, you can save this unit as a schematic module. 
Via File > Save as Module: 

EasyEDA support create the PCB modules, it seems schematic module. 

How to Create 

Via: Save as Module and File > New > Schematic/PCB Module。 
 

PCB module save at Library > Schematic/PCB module > Work Space > My Libraries 



 
 
 

How to use 

Since v6.4.3, after placing schematic modules and PCB modules, after Import Changes, 
supports to keep the layout location. 

How to use: 

1. Draw schematic modules and PCB modules, and ensure that their component prefix are 
one to one, and the footprint is also corresponding. The module's component prefix can 
not have question marks and duplicate prefix, such as U? or two R1. 

2. Open schematic and PCB at a same project. 
3. Open "Library", select the module. 
4. Click the "Place" button to place the previous saved schematic module and PCB module. 
5. It will pop up a window to enter English letter. The letter of schematic module should 

keep corresponding with PCB modules. 

 
For example: A component at schematic module is U2, enter letter K, press OK to place 
into canvas, it will be KU2, then PCB module has KU2 too. 
Click "OK" and enter the placement mode. After each placement, the pop-up will 
continue to enter the identification letter. Make sure that the identification letters entered 
each time are unique. 

6. When finish the module place, the PCB component unique ID will same as Schematic 
component unique ID, then after Import Changes, the component's location will be keep. 
and you can update the track's net follow the schematic netlabel too. 

That implement the multipe chanel placing. 



Notice: 

Module composes by tracks and components, it doesn't same as symbol binding 
footprint, the schematic module can not binding PCB module, after placing, the module 
will be separated by many objects, only the symbol and footprint can be corresponding 
via component ID, that is why you need to make the identication letter unique for placing 
each time to make sure schematic module corresponding with PCB module. 

 
 

 
 

Schematic Theme 
 

 

EasyEDA support a powerful theme feature for the schematic design. 

Via: Top Menu - View - Theme. 

 
 

Original Theme：The default theme, only works for the new part placing. 

White on Black：White on Black, the objects will be white, the background will be black. 

Black on White：Black on White. 



User Definded：When change to this theme style, the schematic will follow your theme 
options "My theme". 

My Theme：Custom theme, which is stored locally in the browser and it will be synchronized 
to the server. When click apply, this theme will be applied to the current schematic. Next time 
you open the schematic, the theme of the schematic will be a custom theme. 

My theme Settings：You can apply "My theme" on: 1. Creating New Schematic, 2.Opening 
Existed Schematic. 

If you used any theme for the schematic, you need to UNDO to go back previous color theme. 
The "Original Theme" can't help. 

Your schematic theme will synchronized to the server by default. 

 
 

Export BOM 
 

 

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB, via: "Top 
Menu - File - Export BOM", or "Top Menu - Fabriaction - BOM". 

 

After clicking the BOM export option, the dialog below will open. 

In this dialog，you can click the buttom to assign LCSC part's order code for your 
components. 

 



After clicking on the assign icon，the components and footprints search dialog will pop up, 
and you can choose which component you want to assign. 

 

When you click the "Order Parts/Check Stock" button, we will help you to list all the 
components of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If 
you want to buy the components form LCSC, and you just need to put them to the cart and 
check out. 

 

You can open the BOM in any text editor or spreadsheet. 



 
 

Export BOM supports to export LCSC part price, it is the same as LCSC website. 

Notice: 

Before v6.4.17, If your project has schematic and PCB, the BOM data will come from 
schematic; if the project only has PCB, the BOM data will come from PCB. 
Since v6.4.17, the schematic BOM and PCB BOM are separated. If you assign the LCSC 
part at the PCB, it will not modify the schematic. 
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or 
PCB manufacturer, please convert the encoding and change the delimiter. 
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV 
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv). 
You can also open the CSV file with any text editor (such as Windows Notepad) and save 
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas. 

 
 
 

Export NetList 
 

 

EasyEDA can export the netlist for the whole active project: 

File > Export NetList > Spice... 



 

EasyEDA can export a netlist in a variety of formats: 

LTSpice for this Sheet: this is a Spice compatible netlist generated by the simulation 
engine of EasyEDA, It is not normally used as the basis for as a PCB layout. 
Protel/Altium for PCB: a PCB netlist in a format that can be imported straight into 
Altium Designer and it's predecessor, Protel. 
PADS for PCB: a PCB netlist in a format that can be imported straight into Pads PCB 
layout tools. 
FreePCB for PCB: a PCB netlist in a format that can be imported straight into FreePCB, a 
free, open source PCB editor for Windows. 

 
 
 

Report Error 
 

 

For EasyEDA official libraries, we have staffs to draw and maintain(LCSC & JLCPCB Assembled 
part) and we will try to keep them correctly as we can, but EasyEDA(System part) included a 
lot of open source of the libraries and the official drawing of the libraries, that can not avoid 
the wrong situation 100%, so when you meet a incorrect library, Please inform us in time, we 
will fix it as soon as possible. 

There are 3 ways to report error: 



1. Right-click the offical library and use the "Report Error" function on the "Libraries". 

 

 

 

 

 

 

 

 

 

 
 

2. Select the offical library on the canvas of the schematic/schematic module, click the "Report 
Error" button at the right-hand panel. 

 



or right-click the component: 

 

 

 

 

 

 

 

 

 

 

 
3. Send Email to us or post a topic at Bug report 

 

 

  

https://easyeda.com/forum/category/2


Experiment no: 13 
Experiment Title: Creating Schematic Symbol in 

EasyEDA 
 

 

Create the Schematic Symbol 

Using Schematic Symbol Wizard and Group/Ungroup... is a quick way to create schematic 
symbols but they are placed directly into the schematic that they are built in. 

It is possible to reuse them by copying them ( CTRL+C hotkeys) from the schematic they were 
created in and then cross-document-pasting them ( CTRL+SHIFT+V hotkeys) into a different 
schematic but this quickly gets messy if you need to copy symbols that were created in several 
different schematics. 

OK, you could keep copying new symbols into a dedicated “symbol library” schematic sheet 
to save searching for them but EasyEDA offers you an easier way to create and manage your 
symbols in a library. 

Start a new Schematic Lib as shown below or by doing: 

1. File > New > Symbol 

This opens the New SchematicLib symbol editor. 

2. Create the symbol 

Get the Datasheet 
For example, using the NE555DR, the datasheet you can refer LCSC: NE555DR. 
And then create the symbol and place the pins for the library base on the datasheet. 
This component have 8 pins and names. 

https://datasheet.lcsc.com/szlcsc/NE555DR_C7593.pdf


 
Create via Schematic Symbol Wizard 

 

The more information of Schematic Symbol Wizard please refer next section. 

Create by Manually 

Draw the shape via the Drawing Tools 

 

 

 

 

 

 

 

 
Place the Pins 

 

 

 

 

 

 

 

 

 
 

The Pin dot must keep out side as the image indicated, it is connecting with the 
wires. The more information please refer SchematicLib Attributes - Pins Section. 



3. Edit the pin map 
Via Edit > Pin Map..., change Pin names and Pin numbers. For some complicated IC, will use 
the alphabet for the pin number. 

Note: if the pin is hidden, a network will be generated according to the pin name for 
connection. If it is not necessary, it is recommended not to hide. 

4. Modify the Detail 

such as change Pin length, place text, change Pin color, Pin attributes etc. 

 

 

 

 

 

 

 

 

 
5. Set Costom Attributes 
You can set the supplier, footprint(Suggested, you must assign the footprint via "Footprint 
Manager"), Name(Required), Prefix(Required) for it, the more detail of attributes please refer 
below section: Custom Attributes 



 
 

If the schematiclib need to assign the packahe, the Pin number should match the footprint's 
Pad number. The detail of the footprint assign please refer the Footprint Manager section at 
previous. 

 

If the part's property "Convert to PCB" is set as "No", it will not appear at footprint 
manager. 

6. Set the Origin 
You can via: "Top Menu - Place - Set Canvas Origin - By Center Grid of Symbols" to set the 
origin. 

7. Save your SchameticLib 

You can set this library's owner, datasheet link and tags etc. 



Then a Schematic Symbol is created finish. And the you can find it at "Libraries - SchematicLib 

- Personl" on the left-hand. 

 

 

 

 

 

 

 

 

 
Notice: 

Note the Origin Point. To simplify rotating your symbols when they are placed into the 
canvas, make sure all of your symbols are created as near as possible centered around 
that point. Suggesting the first Pin/Pad or its center to be the origin point. 
Please make sure all pins dot are placed on the grid, otherwise, when place the library on 
the schematic will causing the wiring difficult. 

 
 

Pin Attributes 

Symbols pins are the most important part of any Schematic Lib symbol. They are the things 
that allow wires to be attached to symbols to connect up your circuit. 

You can use the P hotkey to add a Pin or from the Draw Tools pallete: 
 

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the 
menu to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right 
position. The Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either 
placed as directly onto the canvas or as part of a symbol, the mouse has to point to the Pin 
Dot position to automatically start the Wire mode or to join a wire to it. 



 
 

Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and 
pointing away from — the symbol like in example 1(correct position), inside or pointing 
towards the symbol as shown in example 2(wrong position). 

 

When you select a single Pin, the Pin attributes will be shown in the right hand Properties 

panel: 



 
 

Orientation: 0°,90°, 180° and 270°。If you want to create a 45° pin, you need to set it length 
as 0, and draw a line with 45°。 

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the 
desired position using the mouse, so you can move the pin via Start-X and Start-Y. 

Length: Pin length. 

Name: In this example, VCC is the name of the Pin. 

Number: In this example, 1 is the number of the Pin. This number is the pin number of the 
device in a physical footprint. 

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the 
Number. 

Spice Number: These are the pin numbers used to connect your symbol to the corresponding 
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the 
simulation model may be different from the physical footprint pin numbers and - unless the 
model is specifically created to model multiple devices in a single footprint - do not change 
for different instances of a device in a multi-device footprint. The Spice Pin order must 

be numerals only. 

Name Display: If you don't want to show VCC, switch it to NO. 

Number Display: If you don't want to show 1, switch it to NO. 



> 

You can adjust the Name or Number position using your mouse but note that rotate and flip 
applies to the whole pin including the name and pin number; these items cannot be rotated 
and flipped independently of the pin itself. 

Note also that rotate and flip actions do not result in upside down or mirrored pin number or 
names. 

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4:GND as 
blue. In this example, the PIN1 is set as color #880000 , but it shows as red, because it is 
selected. After deselecting it, the pin will appear color #880000 . 

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion. 

Clk: adds a to the inside end of the pin to indicate that the pin is logical clock input. 
 

 

Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the 
symbol is placed on the schematic editor canvas, and then create a net which name same as 
this pin name. 

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it 
was, it would disappear from view and so how would you find it to make it visible again? For 
the same reason this option has no effect in symbols made using Group/Ungroup… 

We may not have thought of everything in EasyEDA but we do try. :) 

Electric: [Undefined, Input, Output, I/O, Power] 

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of 
your Schematic libs. 



CTRL+S 

If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by 
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit 
with the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered 
when using Multi-part Components. 

After created the Lib, use will open the save dialog: 
 

 

After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand 
Navigation panel. 

 



If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select 
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags 
it will appears on All. 

 

 
Custom Attributes 

In the Schematic Lib editor's canvas Properties panel, you will find a Custom 
Attributes section: 

 

 
footprint 

How to change Schematic Symbol's footprint? If you would like to built a PCB, you need to 
assign a footprint for your Schematic symbol. Although there are other ways to do this in 
EasyEDA, here is the right place to do it. When you set a footprint , the footprint's pad 
numbers must match the schematic Lib's pin number, otherwise, when you convert the 
schematic to PCB , there will miss several nets. 

Click in the footprint input box, and the Footprint Manager dialog will open as used to do 
this task in the Schematic Editor. 

The more information please refer to Schematic - Footprint Manager section. 

Notie: 
You have to assign the footprint via the Footprint Manager, otherwise, the Schematic lib will 
not get the footprint correctly. The footprint is linked with SchematicLib by global unique ID 
not the title. 

Prefix 

The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to R?. 
It is filled required. 



Name 

You can change the schematic lib's name here, it is can be different from the part's file name. 

Contributor 

This is your registered user name. When Other EasyEDA's users use your libraries, they will 
remember your contributions! 

 

 

Symbol Subparts 
 

 

We have already touched on how EasyEDA can support Multi-part/Subpart Components , 
but how do you create multi-part components? 

EasyEDA provides a sub parts facility to do this. 

After creating a part, you can right-click the part in the Library > Symbols > Work Space > 
Created section to pop up the content menu. 

Suppose you have created your own symbol for a 74HCT04 hex inverter. 
 

Right Click Add sub part and that will add 74HCT04.1, 

Click again to add 74HCT04.2 , up to 74HCT04.6. 

Then double click on each sub part in turn to modify the Pin Name and Number attributes. 

Easy or what? 
 

 

Schematic Symbol Wizard 
 

 

How many times have you hit a schematic capture roadblock because you couldn't find 
a component symbol? 

Well, in EasyEDA that would be never because the Schematic Symbol Wizard provides a 
quick and easy way to create a general Schematic Symbol symbol. 

Via: Top Menu - Tools - Symbol Wizard 



 
 

Basic Function 

Input the Pins' name Only 

1. Using the NE555 timer as an example: this device is available in a DIP8 package so select 
DIP. Then enter the NE555 pin names into the Pin Names text box separated by new line 
or space, Then press OK. Abracadabra! As if by magic, you will find a perfectly formed 
dual in line 8 pin symbol for the NE555 attached to your mouse cursor, ready to be 
placed! You just need a few seconds to build a NE555 symbol, quickly and easily. 

 
2. The EasyEDA Schematic Symbol Wizard allows you to create DIP, QPF or SIP styles 

symbols. If you are designing Arduino Shields then you will need lots of SIP symbol, so 
you can create a SIP symbol like the one shown below in a few seconds. 

 
3. If you are not too worried that the symbols may not look quite the way people might 

expect and that they may not look anything like the Type you select, then of course you 



* 

can use the wizard to create symbols for any component: 

 

 

 

 

 

 

 

 
Input the Pins' number and name 

Schematic Symbol wizard support you input the pins' number and name. 
As below example, setting every pin's number is easily. 

 

 
Professional Function 

Schematic Symbol Wizard support the professional function, it is easier to create the large and 
complex and more convenient Schematic Symbol. 

1. Download Schematic Symbol Wizard Template.xlsx 

2. Open it via Excel or WPS, and edit each Pins attributes and position, and then copy the 
content and paste in wizard dialog without content title. 

Tip: If you want to create the gap between Pin and Pin, you can use the as below image. 

https://image.easyeda.com/files/Schematic-Library-Wizard-Template.xlsx


 
 

3. The Wizard will create the symbol follow your content. The types you chosen will be ignored. 
 

 
Notice: 

If the content you input wasn't one, two or eight columns, it will shown incorrect format. 
You can use the Key Space to separate the column data. 

 
 
 

  



Experiment no: 14 
Experiment Title: Schematic Symbol Attributes in 

EasyEDA 
 

 

Pin Attributes 

Symbols pins are the most important part of any Schematic Lib symbol. They are the things 
that allow wires to be attached to symbols to connect up your circuit. 

You can use the P hotkey to add a Pin or from the Draw Tools pallete: 

 
 

Pin Orientation 

Before placing it on the canvas, you can use the rotation hotkey or rotate and flip from the 
menu to rotate it to the right orientation. Make sure the Pin Dot(black dot) is in the right 
position. The Pin Dot will be used to connect your wires or netlabels. Whenever a PIN is either 
placed as directly onto the canvas or as part of a symbol, the mouse has to point to the Pin 
Dot position to automatically start the Wire mode or to join a wire to it. 

 

Whenever a Pin is placed as part of a symbol, the Pin dot should be outside of — and 
pointing away from — the symbol like in example 1(correct position), inside or pointing 
towards the symbol as shown in example 2(wrong position). 



 

Pin Attributes 

When you select a single Pin, the Pin attributes will be shown in the right hand Properties 

panel: 

 
 

Orientation: 0°,90°, 180° and 270°。If you want to create a 45° pin, you need to set it length 
as 0, and draw a line with 45°。 

Start-X and Start-Y: The pindot position. Sometimes it may be difficult to move the pin to the 
desired position using the mouse, so you can move the pin via Start-X and Start-Y. 

Length: Pin length. 

Name: In this example, VCC is the name of the Pin. 



> 

Number: In this example, 1 is the number of the Pin. This number is the pin number of the 
device in a physical footprint 

Note that you can use alphanumeric identifiers such as; A1, B1, C1, A2, B2 and so on as the 
Number. 

Spice Number: These are the pin numbers used to connect your symbol to the corresponding 
pins defined by the .model or .subckt used to simulate your device. The pin numbers of the 
simulation model may be different from the physical footprint pin numbers and - unless the 
model is specifically created to model multiple devices in a single footprint - do not change 
for different instances of a device in a multi-device footprint. The Spice Pin order must 

be numerals only. 

Display Name: If you don't want to show VCC, switch it to NO. 

Display Number: If you don't want to show 1, switch it to NO. 

You can adjust the Name or Number position using your mouse but note that rotate and flip 
applies to the whole pin including the name and pin number; these items cannot be rotated 
and flipped independently of the pin itself. 

Note also that rotate and flip actions do not result in upside down or mirrored pin number or 
names. 

Color: You can set the Pin to different colours, such as PIN3:CLK as orange and PIN4:GND as 
blue. In this example, the PIN1 is set as color #880000 , but it shows as red, because it is 
selected. After deselecting it, the pin will appear color #880000 . 

Dot: adds a circle to the inside end of the pin to indicate logical (or analogue) inversion. 

Clock: adds a to the inside end of the pin to indicate that the pin is logical clock input. 
 

Show: YES/NO. Allows you to hide the pin. When set it to NO, this Pin will be hidden when the 
symbol is placed on the schematic editor canvas. 

Note that the pin is not hidden here in the Schematic Lib symbol editor canvas because if it 
was, it would disappear from view and so how would you find it to make it visible again? For 
the same reason this option has no effect in symbols made using Group/Ungroup… 

We may not have thought of everything in EasyEDA but we do try. :) 

Electric: [Undefined, Input, Output, I/O, Power] 

EasyEDA provides Electrical Rules Checking (ERC) right now, But you still need to set electric of 
your Schematic libs. 

If you set the PIN as Power and set the pin to be hidden, then the Pin will be connected by 
Name which is the NetLabel. If the Name is VCC, it will be connected to the net in your circuit 
with the NetLabel or NetFlag VCC. This is helps to keep the schematic clear and uncluttered 
when using Multi-part Components. 



CTRL+S 
After created the Lib, use will open the save dialog: 

 
 

After clicking Save, you will see it appears in Libraries > Symbols > Personal of the left hand 
Navigation panel. 

 

If you want to modify the tag for your new symbol: Libraries > Symbols > Personal > Select 
New Lib > More > Modify, or right-click new Lib > Modify, if your Lib doesn't have the tags 
it will appears on All. 

 



Symbol Custom Attributes 

In the Schematic Lib editor's canvas Properties panel, you will find a Custom 
Attributes section: 

 

Add into BOM 
This part display at BOM or not. 
Convert to PCB 
If you set it as No, this part will not display at Footprint Manager and can't not convert to 
PCB. 
footprint 
To assign a footprint for this part. Only assign one footprint. 
The more information please refer to Schematic - Footprint Manager section. 
Notie: 
You have to assign the footprint via the Footprint Manager, otherwise, the Schematic 
Symbol will not corresponding the Footprint correctly. The Footprint is linked with 
Symbol by global unique ID not the title. 
Pre 
The default Schematic symbol Prefix is U? If you create a resistor, you can set the Prefix to 
R?. It is filled required. 
Name 
You can change the schematic lib's name here, it is can be different from the part's file 
name. 
Contributor 
This is your registered user name. When Other EasyEDA's users use your libraries, they 
will remember your contributions! 

Show symbol value as component name when place 
component at schematic 

For example, a resistor symbol vaule is 2KΩ, name is ABC, but when place it at schematic, it 
will not show 2KΩ as component name, the name is ABC. You can change name to 2KΩ, but it 
not very well. 



EasyEDA doesn't support common function to support this feature yet. 

But, we can edit the symbol file soure to implement this feature. 

How do it works: 

1. Finish symbol and parameter edit. 

2. Open file source. via: Top Menu - File - EasyEDA File Source. 

3. Add or modify the parameter: nameAlias. 

 

 

 

 

 

 

 

 

 

 

 

 
 

This symbol will show 1k as component name after placing at schematic. 

4. Apply after modified, and save. 

You can double click the EElib resistor symbol to get an example.



CTRL+S 

 

 

Personal Libraries 

When you 
library's owner: 

to save the Schematic Symbol, will pop up a dialog, you can choose this 

 

 
 

After finish, you can find your library at the left panel: Library > Symbols > Work Space > All 
 

Tag 

When you select it , right-click it and select the menu "modify", you can add a tag for it. 



 

Favorite 

When you favorite a library, you can find it at Library > Symbols > Work Spacel > Favorite , 
If this library has a tag, the tag will show up too, but you can't edit that. 

But you can via "Clone" or "Edit and save" to create a new library to personal libraries. 
 

 

Edit Symbol in the Library 

When you feel the Schematic Libs can not be satisfied for you, you can edit it. 

Via "Library" > "Search Part/Work Space/LCSC/System" > Select Symbol > Edit 

or you can click the preview image 



 
 

when you finish and save, it will be saved to your personal libraries Work Space and become 
your personal libraries. 

Edit Symbol in the Schematic 

If you want to edit a symbol in the schematic, you can use the Ungroup/Group function. 

On the Wiring Tools palette there is the Group/Ungroup Symbol… button. 

This tool is for you to quickly create or edit schematic library symbols. 

1. Select a symbol 
2. Click the Group/Ungroup Symbol… button 

Up to this point you have a collection of separate pins, a drawn rectangle and some text 
that are all separate items with no particular association with each other. 

3. Edit the shape or pin what you want to change 
4. Select all of the items and click the Group/Ungroup Symbol… button. 

A dialog will be opened: 



 
 

After you click OK, all those separate elements will be grouped together to form your new 
symbol directly in the schematic. 

Using the group function, you can create/edit any symbol in the schematic, easily and quickly. 

 

  



Experiment no: 15 
Experiment Title: PCB Design in EasyEDA 

 

 

After the initial conversion of a schematic to PCB, it is time to learn how to manage EasyEDA's 
PCB Design Editor. 

Canvas Attributes 

Lots of PCB canvas attributes are the same as Schematic canvas attributes. The key is that you 
can set units in PCB canvas attributes. 

 
 

When you select a object at the canvas, you can modify its attributes at the right panel. 

Snap Size: The cursor snapping size. 

Alt Snap: When press hotkey ALT the cursor snapping size. 

Other 

Routing Width: Setting the default routing width. 

Routing Angle: Setting the routing angle. 

Routing Conflict: When routing the track, what to do when impact the difference net 
objects. 

Ignore: The track go through the objects. 
Block: The track will stop when meet the difference net objects. 
RoundTrack: The track will go aroud the difference net objects. 



Remove Loop: Remove the track loop. 

Copper Zone: Setting the copper zone visible or invisible. 
 

 

PCB Tools 
 

 

PCB tools provide many function to fulfill your PCB design requirement. 
Such as: Track, Pad, Via, Text, Arc, Circle, Move, Hole, Image, Canvas Origin, Connect Pad to 
Pad, Copper Area, Solid Region, Measure/Dimension, Rect, Group/Ungroup. etc. 

 

 

Track 

In the schematic editor, we use Wire or the 

 
Hotkey to connect Pins, in a similar way in theW 



W 

P 

PCB editor, we use Track to connect Pads. Track allows you to draw PCB tracks and can be 

found on the PCB Tools palette or using the Hotkey (not T: see above!). 
 

 

When a track is selected, you can find its Length attribute in the right panel. 

 

 

 

 

 

 

 

 

 
If you want to create solder mask for the track, you can click the "Expose Copper" button at 
the right-hand property panel. 

When click the track, you will see the nodes, you can drag it or right-click delete it. 

 
 

when select the point to point separated tracks, you can convert them as Solid Region or 
continus track at right-click menu. 

The more information of routing, please refer at PCB: Route Tracks 

 

Pad 

You can add pads using the Pads button from the Footprint Tools palette or using the 
hotkey. 

https://docs.easyeda.com/PCB/Route/index.html


Round Rectangular OVAL 

 

After selecting one of the pads, you can view and adjust its attributes in the right hand 
Properties panel. 

 
 

Number: Remembering the pin numbers you set in the schematic symbol in your Schematic 
Lib: to connect those schematic symbol pins to the pads in your PCB footprint, the 

pad numbers you set here in the Footprint footprint must be the same. 

Shape: Round , Rectangular , Oval and Polygon. 

EasyEDA supports four shapes: , , and POLYGON . 

PAD will give your more space. 

PAD will let you to create some strange pad. 

OVAL 

POLYGON 



Like in the image below, you can edit the PADs points when you select a POLYGON PAD 

 



Layer: If the pads are part of a SMD footprint, you can set it to Top layer or Bottom layer. 
For through hole components you should set it to Multi-Layer. If it setting as mult-layer, it will 
connect with all copper layers. 

Net: You don't need to enter anything here because at present this footprint is not connected 
to anything in a circuit. 

Width and Height: When the shape is set to Round, Width will equal Height. 

Rotation: Here you can set the Pad's rotation as you want. 

Hole(D):  This is the drill hole diameter for a through hole pad. For a SMD Pad, set its layer to 

TopLayer or BottomLayer. 

Hole Shape: Round and Slot. When it is set as a slot, the Gerber is generated through the 
stitching of multiple drill holes in the corresponding position. If your hole is round, please do 
not set it as a slot, so as to avoid the overlapping error of holes during the production of DFM 
detection. 

Center-X and Center-Y: using these two attributes, you can set the pad's position with more 
precision, compared to using the mouse. 

Plated： Yes or No. When you set it as No, this pad Inner wall do not metallization. 

Paste Mask Expansion: For single layer pad. This property affects the size of the tin area on 
the plate of the steel mesh. If you want to set a pad that is not open in the steel mesh, you can 
set the value to be negative, which is usually larger than the diagonal of the pad. 

Solder Mask Expansion： This property affects the size of the green oil area cover on the 
pad. If you want to set a pad not open covered with green oil, you can set the value to be 
negative, the value is usually set larger than the diagonal of the pad. 

And you can select a track/Solid Region, right-click it and convert to a pad. 

 

 

 

 

 

 

 

 

 

 

 

 
 

Via 



via 

When you want to lay a multilayer PCB, you need to add Vias for nets getting through layer 
and layer. 

 

 
Place a Via on a Track 

When placing a on a track, the track will be cut to two segments, and the via net will 
follow track's net. Placing two vias on a tracks, you will get three segments, then you can 
change one segment to other layer id, or remove one of them. 

 

Place Multiple Vias 

Click the copper area outline, click the "Add/Remove Vias" button. this feature needs the same 
net copper areas on two and more layers in the same time, the cross area will add the vias. 

 

Notice: 

EasyEDA only support the through via for all layers, doesn't support the buried/blind via. 

Text 

You can add more fonts from your computer or download free fonts:  
http://www.fontspace.com/. 

http://www.fontspace.com/
http://www.fontspace.com/


LineWidth 

 

if you need Japanese or Korean you can use Google Noto fonts 

The editor including fonts are: 
(NotoSansCJKsc-DemiLight)[https://github.com/googlefonts/noto-cjk/blob/main/Sans/OTF/Si  
mplifiedChinese/NotoSansCJKsc-DemiLight.otf] 
(NotoSerifCJKsc-Medium)[https://github.com/googlefonts/noto-cjk/blob/main/Serif/OTF/Sim  
plifiedChinese/NotoSerifCJKsc-Medium.otf] 

Select the text, then you can find a Font-family attribute on the right panel like in the image 
below. 

 

Click the add button, then choose the font, the font file must be 

 

So you can add any fonts by yourself. EasyEDA doesn't cache the font on our server, so if you 
close the editor, you need to add the font again by yourself. 

Note: If you use the other font, the 
automatically set by changing the Height . 

 
 

Arc 

attribute is useless, because it will be 

ttf or otf . 

https://github.com/googlei18n/noto-cjk
https://github.com/googlefonts/noto-cjk/blob/main/Sans/OTF/SimplifiedChinese/NotoSansCJKsc-DemiLight.otf
https://github.com/googlefonts/noto-cjk/blob/main/Sans/OTF/SimplifiedChinese/NotoSansCJKsc-DemiLight.otf
https://github.com/googlefonts/noto-cjk/blob/main/Serif/OTF/SimplifiedChinese/NotoSerifCJKsc-Medium.otf
https://github.com/googlefonts/noto-cjk/blob/main/Serif/OTF/SimplifiedChinese/NotoSerifCJKsc-Medium.otf


You can draw many Arcs with different sizes, it's easy to create a pretty cool PCB as you like. 
 

 

EasyEDA provides two Arc tools: 

Start point fixed, you can change the end point position and radius. 

 

 

 

 
Center point fixed, you can change the radius. 



Select the arc, you can change the arc type at property panel, different arc type has different 
drag behavior. 

 

Circle 

You can draw a circle in PCB. If you want to draw a circle at TopLayer or BottomLayer, please 
use Arc. 

 

 

Move 

This option is same as schematic's drag. 

 

 

 

 

 

Hole 



There were lots of users that didn't know how to use PAD or VIA as a HOLE, they asked 
EasyEDA for help, so EasyEDA added a HOLE TOOL in the PCB toolbar. 

 

And if you want to create the slot hole, you can use solid region(Type: NPTH), or route a track, 
and then right-click the "Convert to NPTH" menu. 

Image 

On PCB and Footprint editor, there is a nice feature on the PCB Tools bar. 
 



After clicking on the image icon, you will see the Insert Image window as below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
In this dialog, you can choose your favorite image, EasyEDA support JPG , BMP , PNG , GIF , and 
SVG . Unlike some other EDA tools which only support a Monochrome Bitmap image, EasyEDA 
supports full color, but Monochrome Bitmap is welcome. 

You can adjust the color tolerance, simplify level and reset the image size there. 

And you can select shape invert. 

The image will be inserted to the active layer, if it is not right, you can change the attribute. 
Such as TopSilkLayer. 



Connect Pad to Pad 

Canvas Origin 

This option is the same as schematic's Canvas Origin. 
 

Protractor 

We provide a protractor for PCB tools. 

 

 

 

 

 

 

 

 

 

 
Connect Pad to Pad 

When creating a PCB without a Schematic, none of the pads on the Footprints have nets 
connecting them so there will be no ratlines. 

 

Rather than try to track the pads from scratch, it is a good idea to connect them up by hand 

first using from the PCB Tools palette. This will help you to remember to 

track the pads correctly with fewer mistakes. 



You could also do this by setting net names for all the pads: if the two pads are given the 
same net name then EasyEDA will understand that they are connected together and will 
automatically create a ratline between them. 

 

Or you can set these two pads with the same net name at the right panel Pad Properties after 
you click the pad. 

 

Copper Area 

Sometimes you will want to fill in or flood an area with copper. Usually this copper area will be 
connected to a net such as GND or a supply rail. You can draw the outline of a flood using the 
Copper Area button from the PCB Tools palette. 

 

When selecting a copper area, you can find its attributes from the right hand 

Properties panels. 



 
 

The more information please refer at PCB: Copper Pour 

Solid Region 

EasyEDA has added a new tool Solid Region for PCB design 
 

This is a very useful, quick way to connect Pads. You can draw a Solid Region to include all of 
these pads with same net name, then set the region to the same net name as the pads. It is 
like Copper Area but easier to use for small areas. To use Solid Region like this, set the Type 
attribute (in the right hand Properties panel) to Solid. 

 

The more information please refer at PCB: Solid Region 

Measure/Dimension 

https://docs.easyeda.com/PCB/Copper-Pour/index.html
https://docs.easyeda.com/PCB/Solid-Region/index.html


Making and adding measurements is useful in PCB design. EasyEDA provides two methods to 
do this. 

1. Dimension tool in the PCB Tools palette: 

This tool can show three units on the canvas, milliliter, inch and millimeter. 

 

 

 

 

 

 

 

 

 
When you click one side of the dimension on the PCB, you can drag it for any directions 
or change its length. 

2. Measure a distance using Hotkey M, Or Via: Top Menu > Edit > Measure Distance, then 
click the two points which you would like to measure. 

 
Tips: 

It's unit follows canvas's units. 

You can disable the snap option to measure at the canvas property panel. 

Rect 

It looks like a Solid Region, but it can't be set Nets and you can't set the Layer as NTPH. 



 
 

The rect doesn't rotate, you can change its width and height. 

Group/Ungroup 

Just like Group/Ungroup in the Schematic Editor can be used to create a schematic lib symbol, 
you can use Group/Ungroup from the PCB Tools palette to create a Footprint footprint in the 
PCB editor. 

 

For example, place Tracks and Pads on the canvas, then select all of them and click 

Group/Ungroup to group them like as a footprint in the image below: 
 

Notice： 

Before ungroup the footprint, please change it's layer to top layer first, because of the 
footprint after grouping will at top layer. 



The grouped footprint doesn't support Import Changes, it will be removed if you Import 
Changes. 

 

 

Layers Tool and Objects 
 

 

Layers Tool 

Active Layer: The colours of the layers in the Layers Tool are defined in the Layer Options 
Settings. To work on a layer then you must make it the Active layer. 

To do this, 

Click on the eye icons to show/hide layers. 
The pencil icon in the coloured rectangle indicates that this is the active layer. 
Click the pin icon to fix the layering tool without automatically closing it. 
The height and width of the layer tool can be adjusted when dragging the lower right 
corner of the Layers Tool. 

 

HotKeys for layer activation: 

T: Top Layer is active 
B: Bottom Layer 
1: Inner1 Layer 
2: Inner2 Layer 
3: Inner3 Layer 

4: Inner4 Layer 

The more information for the PCB layers please refer at PCB Layout - Layer Manager 

note: the hidden PCB layer is only visually hidden. The corresponding layer will still be 
exported during photo preview, 3D preview and Gerber export. 

Objects Filter Tool 

https://docs.easyeda.com/en/PCB/Layer-Manager/index.html


Click "Object" to switch to object filtering. 
 

Select： When the tick in front of the object is checked, the corresponding object in the 
canvas can be manipulated with the mouse. Uncheck will not allow mouse operation. 

Including click selection, box selection, drag and other operations. 

Eye： Click eyes to modify the display and hiding of corresponding objects in batches. 

Component：Displays or hides the entire components, excluding the component's name 
and prefix 
Prefix：Displays or hides the entire components' prefix 
Name：Displays or hides the entire components' name 
Track：Displays or hides the entire tracks, for all layers 
Pad：Displays or hides the entire free pads, excluding the pads in the component 
Copper Area：Displays or hides the entire copper areas' fill area, excluding copper 
outline 

Text：Displays or hides the entire normal texts, excluding the text of the component 

Note: 

The layer and object invisible and visible will not go into Undo and Redo. 

 
 
 

Layer Manager 
 

 

Layer Manager 

You can set the PCB layer's parameters at the Layer Manager. 

Via Top Menu> Tools > Layer Manager..., Or Click Layers Tool gear icon. Or right-click the 
canvas - Layer Manager menu. 

The Layer Manager dialog: 



 

The Layer Manager setting only works for the current editing PCB. 

Copper Layer: The copper layer of your PCB. EasyEDA support 34 copper layers. The more 
copper layers the PCB will be more expensive. The TopLayer and BottomLayer is default layer, 
can not be disable. If you want change the copper layers from 4 to 2, you must delete the 
inner layers objects first. 

Display: If you don't want a layer dosen't display at "Layers Tool", you can disable the 
checkbox. Notice: This option only hide the layer name on the "Layers Tool", the objects of 
the hidden layer still exist, when you generating the Gerber, they will appear. 

Name: Layers name. For the inner layer, you can define the name. 

Type: 

Signal: Which is working for the signal. Such as Top and bottom layer. 
Plane: When the inner layer type is "Plane", this layer will be copper pourred, if you want 
to separate the copper area you can draw the Track or Arc. You can treat this layer is a 
only has the copper area, but its easy than draw the copper area. The track you routed 
will generate the clearance when generating the Gerber. The "Plane" usually is using for 
the Power or Ground copper pour on the inner layer. You can set the net for the plane 
zone. 



 
Notice: 
When draw the track to separate the plane zone, the track start ponit and end point must 
over the middle line of the board oultine track. Otherwise, the plane zone will not be 
separated; When using the plane layer, the PCB can not exist two closed borad outline, 
only one closed board outline will generate the plane zone. 

Non-Signal：Such as silk screen, mechanical layer, document layer etc. 

Color: You can define the color for each layer. 

Transparency: You can change the layer transparency. 

Layer Definination: 

TopLayer/BottomLayer: The top side and bottom side of the PCB board, copper layer. 
InnerLayer: Copper layer, routing track and copper pour. 
TopSilkLayer/BottomSilkLayer: Board silkscreen. 
TopPasteMaskLayer/BottomPasteMaskLayer: This layer is the layer used to make the 
stencil for the SMT pads, helping to solder. This layer has no effect on production if the 
board is not required to make the stencil. 
TopSolderMaskLayer/BottomSolderMaskLayer: The top and bottom cover layers of the 
board are typically green oil, which acts to prevent unwanted welding. This layer belongs 
to the negative film drawing mode. When you have wires or areas that do not need to 
cover green oil, draw them at the corresponding positions. After the PCB is generated, 
these areas will not be covered with green oil, which is convenient for operations such as 
tinning. 
BoardOutline: The board shape definition layer. To define the actual size of the board, 
the board factory will produce the board according to this shape. 
TopAssemblyLayer/BottomAssemblyLayer: Simplified outline of components for 
product assembly and repair. Used to export document printing, without affecting PCB 
production. 
MechanicalLayer: Record the information on the mechanical layer in the PCB design, and 
only use it for information recording. By default, the shape of the layer is not 
manufactured at the time of production. Some board manufacturers use the mechanical 
layer to make the frame when using Altium file to production. When using Gerber file, it 
is only used for text identification in JLCPCB. For example: process parameters; V cut path 
etc. In EasyEDA, this layer does not affect the shape of the border of the board. If the 
mechanical layer has closed wires, JLCPCB will give priority to using the mechanical layer 
as the shape of the board when producing the board. If there is no outer frame of the 
mechanical layer, GKO will be used as the frame (historical influence of Altium file). It is 
necessary to pay attention to the use of the mechanical layer in the design. 



DocumentLayer: Similar to the mechanical layer. But this layer is only visible in the editor 
and will not be generated in the Gerber file. 
RatlineLayer: PCB network ratline display, this layer is not in the physical sense, in order 
to facilitate the use and set color, it is placed in the layer manager for configuration. 
HoleLayer: Similar to the RatlineLayer. For Hole(Non-Plated Hole) display. 
Multi-Layer: Similar to the RatlineLayer. For multi-layer hole(Plated hole) display. If the 
PAD setting layer property as mult-layer, it will connect with all copper layers. 

DRCErrorLayer Similar to the RatlineLayer. For DRC(Design Rule Error) marking dispaly. 

Layout Single Layer PCB 

The PCB copper layers of EasyEDA are double, EasyEDA doesn't support layout a signle layer 
directly. if you want to layout a single layer PCB(such as only layout on the bottom layer), 

There are two methods: 

Method 1: 

Route the track and copper on the bottom layer, and without placing via. 
If you are using the footprints which have the multi-layer pads, that will appear on the 
top and bottom layer, then you need to change all multi-layer pads "Plated" as "No". 
Generate the Gerber, decompress the Gerber zip file, delete the layers which you don't 
need(such as Gerber_TopLayer.GTL, Gerber_TopSilkLayer.GTO, 
Gerber_TopSolderMaskLayer.GTS, Gerber_TopPasteMaskLayer.GTP). 

And re-compress the Gerber to a zip file, and order it. 

Method 2: 

Design your PCB at one side, if other side has pads etc, you don't need to deal with them. 
Generate the Gerber. 
Add the comment for mention that you need to order the signle layer PCB when order 
the PCB. 

 

 

Ratline 
 

 

 
When you layout the track in the PCB, Between Pad and Pad as they have the same net name, 
a Ratline will be automatically shown among them to reveal that they can be connected with a 
track. 



+5V 

 
 

1. If you want one ratline do not show on the PCB editor, you can deselect the net in the 
design manager, as below deselect +5V : 

If you still draw a track in after deselecting, canvas will not display this track and 

ratline , but it will show a net text with +5V as below. 

 

 

 

 

 

 

Based on this skill， you don't need to lay GND net before copper area in the PCB. 
2. If you want to check the ratlines with highlight, you can click the pencil on the Ratlines 

Layer as below, and you can change the ratline's color at Layer Manager. 

 
3. If you want to hightlight one ratline all the time, you can click a pad, press hotkey H, 

press it again unhighlight. 

4. If you want to change one ratline's color, you can set it at: - Tools - Net Color. After 
setting the color, you need to click the plus icon on the right. The color is not affected by 



CTR+Q 

the color of the ratline layer. 

 

 

 

 

 

 

 

 

 

 
 

5. If you want to remove one ratline, you just need to remove objects' net. Select it and 
empty the net. 

 
 
 

PCB Net 
 

 

Net Name Visible 

PCB editor can display net name in the track or Pads, if you don't need this feature, just need 
to turn it off via： 

Top Menu > View > PCB Net Visible, or press hotkey . 
 



 
 

Net Length 

After selecting a track, and then pressing 

 
key or click its net at Design Manager, EasyEDA 

will highlight the whole net and pop a message box to tell you the whole net's length. like in 
the image below 

 

Net Color 

If you want to change one Ratline's or Net's color, you can set it at: Top Menu- Tools - Net 
Color. After setting the color, you need to click the plus icon on the right. The color is not 
affected by the color of the ratline layer. 

 

H 



When you set a color for a net, you need to click the + button to make it works. 
 

 

Board Outline 
 

 

 
Before placing footprints we need to create a board outline. The board outline must be drawn 
on the Board OutLine layer. So first, set Board OutLine as the active layer, then draw the 
board outline using Track and Arc from the PCB Tools palette. 

 

When converting a Schematic to PCB, EasyEDA will try to create a board outline for you. 

The area of the default board outline area is 1.5 times the sum of the area of all of your 
footprints, so you can place all of your footprints into this board outline with some allowance 
for tracking. If you do not like the board outline, you can remove the elements it is made up 
from and draw your own. 



 
 

To create a simple rectangular board outline, this arc can be removed and the line X and Y end 
points edited - either directly in the Properties panel or by dragging the line ends - to close 
the rectangle. 

And EasyEDA provides a Board outline wizard, so it is very easy to create a board outline. 
Via: Top Menu > Tools > Set Board Outline, Or find it on the toolbar. 

 

In this dialog, there's a choice of 3 types of board outlines, Rectangular , Circular, Round Rect. 
If you need a different more complex board outline, you need to import a DXF file. 

Notice： 



+ - 

TAB 

When generate the Gerber, EasyEDA will show error if the board outline doesn't closed or 
the board outline tracks overlap. 

You can cutout the hole by using the board outline, or use Hole , or 

to create the hole instead of using the board outline. 

You can right-click track or circle to convert to board coutout. 

If the board outline doesn't closed, the copper pour will not show up. 

 
 
 

Route Tracks 
 

 

 

Route Tracks 

In the schematic editor, we use Wire or the 

 
Hotkey to connect Pins, in a similar way in the 

PCB editor, we use Track to connect Pads. Track allows you to draw PCB tracks and can be 

found on the PCB Tools palette or using the 

Some Tips about Track 

Hotkey (not T). 

Single click to start drawing a track. Single click again to pin the track to the canvas and 
continue on from that point. Right click to end a track. Double right-click to exit track 
mode. 

 
Drawing a track at the same time as using a hotkey(for example hotkey B ) for changing 
the active layer will automatically insert a Via: 

 

If you start drawing a track on the top layer, you will see it drawn in red, then press the B key 
to change to bottom layer and you will see EasyEDA insert a grey via and then the track will 
continue being drawn but now on the bottom layer in blue. 

Pressing the or Hotkeys when drawing the track will change the width of the track 

on the fly. Use the hotkey to change the track width. 

Solid Region(Type: 

Board Cutout) 

W 

W 



 

 
Double clicking on a drawn section of the track will add a new vertex at that point. You 
can drag the vertex to form a new corner. And you can right-click the point and delete it. 

 

Click to select the track and then Click and Drag on a segment of the track to adjust the 
segment between vertices. 

 

When the track's corner is a right Angle and the routing corner is 45, drag the track next 
to the right Angle node to make a bevel. Instead of dragging a node directly, dragging a 



L 

You can change inflection direction when routing, just press Space key. 

node directly will drag the entire track. 

 

 

 

 

 

 
Selected a track, you can delete its node point. 

 

 

 

 

 

 

 

 
Pressing the Hotkey when drawing the track will change the track's Route Angle on the 
fly. And you can change Route Angle on the Canvas Attributes of the right panel before 
the next drawing. 

 
 

If you want to route a track and use "L", and the then press "+", you will get two different 
size track segment. or press "SHIFT+W". 



 
 

If you want to create the solder mask aperture for the track, you can use "Expose Copper" 
when you select the track on the right-hand panel. The solder mask will bigger 4mil than 
the track. 

 

And if you want to create the slot hole, you can route a track, and then right-click the 
"Convert to Board Cutout" menu. 



SHIFT 

 
 

You can make track routing width follow design rule, after enable the design rule option. 

 

 

 

 

 

 
Right-click the track, you can select the track connection or a whole same net tracks. 

 

 

 

 

 

 

 

 

 

 

 

 

 
If you want to the whole track, you can press and move it. 



You can disable the DRC boundary at Desgin Rule. The size follow the rule. 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

If you want to continue routing for a net, you can disable the "Terminate Routing 
Automatically" option at "Setting - System Setting - PCB". 

 



Set up Remove Loop while routing, it only works on copper layer. 

 

 

 

 

 
 

Using Routing Conflict as "RoundTrack" will help you finish routing quickly. 

 

 

 

 

 
 

When edit the footprint document, you can set up the "Cut Silkscreen" to avoid the 
silkscreen track overlap the pad. 

 

Track Length 



When a track is selected, you can find its Length attribute in the right panel. 

 

 

 

 

 

 

 

 

 

 

 

 
At left-hand Design Manager, click a net, will pop up a dialog to show you this net track 
length. 
Click a track, press hotkey H will keep hightlight this track and net, and show this net's 
length. 

Delete a Segment from a Track 

While routing, if you want to undo previous track path, you can press key "Delete" or 
"Backspace". 
Move your mouse to the segment which you want to delete, click it, then hold 
double click it. the segment will be removed. Or right-click delete the node. 
Right-click the track node to delete the track 

Click the track, right-click delete it, or press "Delete" key directly. 

DRC outline 

and 

When you routing a track on the signal layer, you will see an outline around the first track, it is 
the DRC outline, the clearance from outline to the track edge depends on your Design 
Rule(DRC) clearance setting. 

SHIFT 



 
 

Routing Conflict 

When the PCB comes from the schematic converted, the "Routing Conflict - Block" will be 
opened automatically. 

At the right-hand attributes panel - others, you can find a "Routing Conflict" option: 
 

Ignore: You can route the track overlap the different net name objects. 
Block: If the track net name different with other objects, this track will be blocked when 
routing. 
RoundTrack: The track while routing will walk arroud the different net objects. 
Push： Doesn't develop yet. 

Differential Pair Routing 

EasyEDA provide a easy experience for the differential pair routing. 
Via: Top Menu - Route - Differential Pair Routing 

You must make sure the Differential Pair net names must be 

and you need to set Differential Pair net rule at the "Top Menu - Tool - Design Rule" first. 

How to route Differential Pair: 

1. Set the Differential Pair net name as 

the Differential Pair net at the "Design Rule" 

2. Click the menu 

3. Click the one pad of the Differential Pair pads 

or XXX+,XXX- , and set the rule for 

XXX_N, XXX_P or XXX+,XXX- . 

XXX_N, XXX_P 

Top Menu - Route - Differential Pair Routing 



4.Routing 

 

 

 

 

 

 

 
Notice: 

Only for 45 degrees routing, doesn't support hotkey L and Space key. 
Doesn't support the fanout routing. 

Doesn't support the DRC blocking. 

Known Issue: 

When finish previous routing location too close with the finish pads, the track will 
generate the extra segments, please finish the previous location far away from finish 
pads. 

 

Track length Tunning 

You can tunning your track very easy on the editor. 

Via: Top Menu - Route - Track length Tuning 



 
 

How to use: 

1. Select the track which is you want to tune 

2. Click the menu: 

3. Set the parameter, start 
4. Left-Click the track where is you want to start, and then move the mouse 

5. When the track length close your setting, it will stop tunning. 

 

 

 

 

 

 

 
Notice： 

Doesn't support one side tunning for a track yet 

Doesn't support auto push or avoid the nearby tracks yet 

Cloud Auto Router 

Top Menu - Route - Track length Tunning 



For some simple or prototype PCBs, you may want to use the auto router function to save 
time. Layout is a time costly and dull job. EasyEDA spends lots of time to provide such a 
feature and it is loved by our users. 

Before using the auto router, you need to set the board outline for the PCB. 

Auto router is not good enough! Suggest routing manually! You can use 
"RoundTrack(Walk Arroud)" option to route tracks, via right-hand panel - Routing 
Conflict. 

Steps: 

1 Click the the auto router button from the Top Menu"Top Menu> Route > Auto Router" 

2 Config the auto router 

After you click that button, you will get a config dialog like in the image below. 

 

 

In the config dialog, you can set some rules to make the auto router result professional. These 
rule must equalize or more than DRC setting. 

General Options 

Unit: The unit follows PCB canvas unit. 

Track width: The auto-route track width. 

Clearance: The clearance of the objects. 

Via Diameter/Via Drill Diameter: The via placing by auto-router. 

Realtime Display: when you select it , the real time routing status will show on. 

Router Server: 

Cloud: Using EasyEDA online server. 
Local: Using the local auto router server, when you click the Auto Router icon, the 
editor will check the local router server available or not automatically. How to use 



please see as below. 

Router Layers: If you want to route inner layer, you have to enable the inner layer first. 

Special Nets: For the power supply track, you may want it to be bigger, so you can add 
some special rules. 

Skip Nets:  If you like to keep the a net with no route, you can skip it. For example, if you 

want to use copper area to connect net, you can skip the net. If you want to 

reserve the routed track, you need to select the 

3 Run it 

Skip Routed Nets . 

After click the "Run" button , The real time check box will let you see how it is going, but it 
will make the process a little bit slow. 

 

Waiting for a few minutes, after adding bottom and top copper area, you will get a finished 
PCB board. 

When finish, will pop up a window. 
 

The connection means the track connect times. 

Notice： 

The parameter can't less than DRC rule, otherwise will report error. 

GND GND 



win64.bat 

- Windows7(x64) or later 64bit Windows 

- Ubuntu17.04(x64) or other 64bit Linux, Linux recommend [Deepin] 

(https://www.deepin.org) 

- macOS(x64) 

network.websocket.allowInsecureFromHTTPS 

security.mixed_content.block_active_content 

Local Auto Router 

EasyEDA suggest that using local auto router rather than using the cloud server, because 
when many users using cloud server, the cloud auto router will fail. Only support 64bit system. 

 
For the local auto router, please follow the steps as below: 

1. Download the local auto router server. 

Download EasyEDA Router： 
easyeda-router-windows-x64-v0.8.11.zip 
easyeda-router-linux-x64-v0.8.11.zip 
easyeda-router-mac-x64-v0.8.11.zip 

 
Supported OS: 

 

 

2. Unzip it to the User folder, such as driver D. 

3.Configure the browser. 

Notice: Please use the latest Chrome or Firefox !!! 

1)Chrome 
The Chrome Browser don't need to be configure, If the local auto router is 
unavailable, you have to upgrade Chrome to version 60.0.3112.78 or later. 

2)Firefox 

1. Type "about:config" into the address bar then press enter. 

2. Search and double click the options as below (change the values to "true"): 
 

 

 

- 3.Re-open Firefox. 

4. Open the decompress folder, Start local Auto Router(don't need to install, just run 
it and keep the command window open): 

Double click in Windows. 

https://image.easyeda.com/files/easyeda-router-windows-x64-v0.8.11.zip
https://image.easyeda.com/files/easyeda-router-linux-x64-v0.8.11.zip
https://image.easyeda.com/files/easyeda-router-mac-x64-v0.8.11.zip


sh lin64.sh 

sh mac64.sh 

Run on command terminal in Linux. Open the terminal, use the 
command to change the directory to the 
then enter. 

location, and type sh lin64.sh , 

Run on command prompt in MacOS. Open the terminal, use the 
command to change the directory to the 
then enter. 

location, and type sh mac64.sh , 

 

 

 

 
Tips 

5. Open the editor, open the PCB, Click the Auto Router** icon at editor to start auto- 

router.** 
If the local router server is available, the dialog will tell you. Click the Run button, the 
dialog will show the process. 

Auto router is not good enough, suggest routing manually, recommed "Routing Confilct - 
RoundTrack" at the PCB right-hand panel. 

Sometimes, if you can't get it done, try the tips below. 

Use local auto router rather than cloud server. 
Make sure the net of PCB doesn't contain the special charaters, such as ` { } ^ ; ~ \ / [ ] = 
etc. the chrarter - and _ are supported. 
Make sure the board oultine is closed, doesn't has board oultine overlap situation. 
Make sure there are no DRC cleance errors (short circuit issue), such as two different 
network pads overlapping, or different net pads in the same location within the package. 
Make sure no footprint outside the board outline. 
Make sure your canvas Gird size is set to 10mil, make sure the components align with the 
grid via: top menu - format - align grid. 
Place some vias at suitable position, and modify the vias' net as you want. 
Make sure PCB rule doesn't have 3 decimal places, EasyEDA auto router only support 2 
decimal places. 
Skip the GND nets, add copper area to GND net. 
Use small tracks and small clearance, but make sure the value is more than 6mil. 
Route some key tracks manually before auto routing and ignore them when auto routing. 
Add more layers, 4 layers or 6 layers. but that will make more cost. 
Change the components layout, make them have more space between each other. 
Don't make any via/pad overlap the different objects which can be set the net. 
Stop the auto-router, close the script, and re-open the script to run local auto-router 
server again. 
Sometimes, The auto-router won't work at the first time, please modify the layout and try 
serveral times. 
If only a few remaining networks cannot be completed, it is a normal phenomenon. 
Please manually route the remaining networks. 
Tell the error detail to us and send your PCB file as EasyEDA Source file to support@easye 
da.com. 
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html  
via email. 

 

 
Some professional people don't like the auto router, because they think auto router is not 
professional, but you can use the auto router to check your placement to check the density of 
your PCB. 

cd 

lin64.sh 

cd 

mac64.sh 

mailto:support@easyeda.com
mailto:support@easyeda.com
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html


At present, the auto router is not good enough, suggest routing manually, we will improve it 
in the future. 

 

 

Copper Area 
 

 

Copper Area 

Sometimes you will want to fill in or flood an area with copper(Copper Pour). Normally after 
drawing the copper area, set the net it is to be connected to (floating copper areas are not 
recommended because they can cause EMC and Signal Integrity (SI) problems). 

 

Before using Copper Area, please make sure your PCB has a closed board outline! 

Usually this copper area will be connected to a net such as GND or a supply rail. You can draw 
the outline of a flood using the Copper Area button from the PCB Tools palette. 

Copper Area Attributes 

When selecting the copper area outline, you can find its attributes from the right hand 

Properties panels. 



 

Layer: Bottom, Top, Inner1, Inner2, Inner3, Inner4 etc.; 

Net: the net that the copper area is connected to; 

Name: set a name for it. 

Clearance: clearance of the copper area from other nets and floods; 

Pad Connection: direct or spoke (i.e. a cross shaped heat shunt); 

Spoke Width: When Pad Connection is Spoke, you can set the Spoke width, which is copper 
area fill connect with Pads. 

Keep Island: Yes/No. This keeps or removes any isolated areas of copper created as part of 
the flooding process. It is usually good practice to removes these unless you really need them 
to maintain a more even spread of copper (copper balance) on your PCB. 

Fill Style: Solid/No Solid/Grid. Selecting No Solid will removes the fill so that you can see the 
tracks more clearly; when select Grid, you can set the grid spacing and grid width. 

Copper to BoardOutline: Setting the clearance between copper with board outline. 

Improve Fabrcation: Yes/No. If you set as No, you will see much sharp copper corners, that is 
not good for PCB fabrication. 

Rebuild CopperArea: Click the button to Rebuild Copper Area if you make any changes. 

Edit Points: You can edit the copper area shape manually, any shap as you want. 



Shift+B 

Delete BackSpace 

Add/Remove Vias: When you add copper areas at two and more layers which are having 
same net, you can add multiple vias for the copper fill area, just click the "Add/Remove Via" 
button, then set the via parameter. The vias will avoid the objects if the via conflict the DRC. 

 
 

Tips 

Hotkey 
Hotkey 
Hotkey 
Hotkey 

 
to start draw copper area. 
to change drawing type(90 degrees or 45 degrees or Arc) 

to build all of the copper areas. 

to hide copper areas fill zone, just show the copper outline. 

Hotkey or to redo previous steps. 
If you after copper pours but no copper fills show up, you need to set it a net same one 
of the PCB nets, or keep the island as YES, and the rebuild the copper area via "Rebuild 
Copper Area" button or "SHIFT+B". 
If you want to hide the copper area and keep routing tracks, you can set the copper zone 
invisible at the right-hand panel. 

 
If you want to cutout some copper corners, you can use "Solid Region - No Solid", and 
then set different net for it, and rebuild the copper area. 

E 

L 

Shift+M 



Shift+B 

 
 

Notice 
 

Because of the browser's performance issue, EasyEDA doesn't support the real-time 
copper pour, after PCB modifying, please rebuild copper area via Hotkey . 
EasyEDA doesn't support click the copper zone, you need to click the copper outline to 
select it. 
If the PCB size is more than 15MB, the copper filled data is stored in the client or 
browser(that is because some copper filled data is too large to save at server), and 
the copper area outline data is stored in the file. Therefore, when the PCB is opened 
for the first time, the copper area filled data will be automatically pouring and saving 
at local, and the second time the PCB is opened, the filled data will be automatically 
loaded from the local storage. When you need to draw the forbidden copper-laying 
area, please use the "No Solid" property of "Fill Type" to cutout the copper area and 
rebuild it, do not use the operation of drawing the area with wires or circles and then 
removing the wires or circles to create the forbidden copper pour area. If the PCB 
size is less than 15MB, the copper filled data will be saved into file, and you can open 
the PCB in another PC without rebuild copper area. 

FAQ 

Why sometimes it takes a long time to copper pour 

Check that the PCB has a large number of polygon pads, which generally appear in the 
PCB imported Altium Design files, and if so, manually modify them to Round or Rectangle 



copper net needs to be set to VCC . 

pads. 

 

 

 

 

 

 

 
 

Check if there are a large number of wire arcs, generally appear in the imported Altium 
Design PCB, Altium Design picture is a large number of track segments combined, need 
to be manually removed. 
Check that the board outline is complicated, with overlapping board outlines, or a large 
number of board outlines, adjust them manually to reduce the number of board outlines. 

 

Why did I not show the copper fill after copper poured 

Your copper area net must have the same pad or via same as the current layer, otherwise 
it will be considered an island to be removed. Click on the copper wire frame to modify 
the net in the property panel on the right. For example, your pad net is VCC , you lay 

If you don't change the copper area ne, you can click on the copper outline and modify 
the property "Keep Island" to Yes in the right property panel. 
The copper area logic of the EasyEAD is based on whether there is a connection or not to 
decide whether it is an island, and if there is no element connection to the same net, the 



copper area will be considered an island. 

 

 

 

 
Check that the editor version is 6.3 above, 6.3 PCB board open in version 6.2 can not 
properly copper pour. Please CTRL+F5 refresh editor page upgrade to 6.3, if it is true that 
can not upgrade to 6.3, you must remove the copper area and redraw. 

 

Check that the board outline is closed and that endpoints need to be closed between the 
tracks, and that there are overlapping segments of the board outline (usually inside the 
imported PCB). Once you can hide all layers, only the board outline layer view is 
displayed, and each segment is carefully examined. 

 
Check that the copper area property is set to type No Solid and needs to be set to Solid 
or Grid. 



 

Whether to make the copper area invisible, on the right side of the canvas, set the copper 
zone to Visible. 

 

Still unable to copper pour may be an editor bug, please contact us. 

Why the ratline doesn't disappear when two copper area overlap which are the same net 

At present, doesn't support this, that will make the ratline generation very slow. Please 
route a track manually to connect these copper areas. 

 

Copper Area Manager 

EasyEDA support copper area manager now, you can set the copper order and apply, the 
forward copper area will be poured first. 

Via: Top Menu - Tools - Copper Area Manager 



 

For example： 

The GND on the top and VCC on the top, you can see the clearance is different. 
 

 
 

Solid Region 
 

 

EasyEDA has added a new tool Solid Region for PCB design 
 



This is a very useful, quick way to connect Pads. You can draw a Solid Region to include all of 
these pads with same net name, then set the region to the same net name as the pads. It is 
like Copper Area but easier to use for small areas. To use Solid Region like this, set the Type 
attribute (in the right hand Properties panel) to Solid. 

When you drawing the solid region, you can use the hotkey and to change the route 

type(Arc, 90 degrees, 45 degrees, Free Angle), just like the track routing. 

When you finish drawing, you can click the solid region and change its attributes at the right- 
hand panel. 

Layer: Solid Region su pport many layers, you need to enable the layer at the Layer 
Manager first. 

Net: When change to top or bottom or other inner signal layer, the solid region can be 
set a net to connect other objects. Sometimes, you can use solid region to make the 
copper instead of "Copper Area". 

Type: Solid,Board Cutout,No Solid , 

Solid: It will fill the solid area. 
No Solid: It will cutout the area such as copper area. Notice, if you cutout a 
copper area, the solid region's net must different than copper area's net. After 
setting to this option, you need to rebuild the copper area with SHIFT+B. 
Board Cutout: you can use this feature to create a slot hole(Non Plated Through 
Hole). 

 
Edit Points: You can edit the solid region's outline points as you want. 

Expose Copper: ou can create an aperture in the solder mask by one click. It's very easy 
to do. 

The outline of the solid region can not be self-intersection, when it happens, please delete the 
self-interation point at "Edit Points". 

 

 
 

Design Rule Check(DRC) 
 

L space 



 

 

EasyEDA provides a real time DRC(Design Rule Check) function. This is a big feature of 
EasyEDA. It is hard to fix DRC errors after laying out the PCB. Now EasyEDA will let you know 

the error in routing. You will find an 

Design Rule Setting 

flag to mark the error. 

Via at: Tools > Design Rule..., or Via: right-click the canvas - Design Rule... to open the 

Design Rule setting dialog: 
 

The unit follow the canvas unit. 

Rule: The default rule named "Default", you can add the new rule you can rename and set 
parameters for it. Each net can be set a rule. 

Track Width: Current rule's track width. The PCB track width can not less than this value. 

Clearance: The clearance of different objects which have different net. The clearance of the 
PCB can not less than this value. 

Via Diameter: The via diameter of current rule. The via diameter of the PCB can not less than 
this value. Such as the Hole/Multi-layer Pad's diameter. 

Via Drill Diameter: The via drill diameter of current rule. The via drill diameter of the PCB can 
not less than this value. 

Track Length: All track length of current rule. The length of tracks belong to a same net 
should not be longer than this value.Including the arc lenghth. When the input box is empty 
the length will be unlimited. 

Realtime DRC: After enable, when you routing the DRC will checking all the time, when 
appear the error the canvas will show the "X" marking. 

X 



 

Check Object to Copper Area: Check the clearance of the objects to copper area. If you 
disable this option, you must rebuild the copper area before generating the Gerber with 
SHIFT+B. 

Check Object to Board Outline: When you enable, you can set a value to check the clearance 
of the objects to board outline. 

Apply Design Rule while Routing and Placing Via: When you routing and placing a new via, 
them will follow the design rule to set them width and size. 

Show DRC Boundary while Routing: When routing you will see a oultine around the track. Its 
diameter depends on desgin rule. 

Set Rule for a Net 

1. Click the "new" button to create a rule, or use the default rule 
2. Select one or more networks on the right, support holding down the CTRL key for 

multiple selection, and also can perform keyword filtering and rule classification filtering 
3. Then select the rule you want to set in the "set rules" section below and click the "apply" 

button. The network applies the rule. 

4. Click the "Settings" button to apply the rule. 

Check the DRC Error 

Via "Design Manager - DRC Error" or "Top Menu - Design - Check DRC", click the refresh 
icon to run the DRC. If your PCB is a big file, and have the copper area that will take some 
times to check the DRC, please wait a while. 

 



After checking, you can view all the error at the "DRC Error", click the error the related objects 
will be highlighted. 

 

DRC error type 

Clearance: Object to Object. If two different net objects too close, and the distance less 
than the Design Rule clearance, it will show the Clrearance error. 

 

Track Length: The track Length of the all same net tracks must less than Design Rule track 
Length. 



 

Track Width: The track width must must large than Design Rule track width. 

 

 

 

 

 

 

 

 
Via Diameter: The via diameter must large than Design Rule diameter. 



Via Drill Diameter: The via drill diameter must large than Design Rule drill diameter. 

 

 

 

 

 

 

 
Note: 

 

When you convert a schematic to PCB, the real time DRC is enable. But in the old PCB, 
the real time DRC is disable. you can enable it in the image as above. 
Design rule checking can only help you find some obvious errors. 
The color of the DRC error can be set in the layer manager. 

 

 

Footprint Attributes 
 

 

When selecting a Footprint, you can find its attributes at the right hand Properties panel. 
 

Prefix: It is same as the schematic. If you move the prefix too far away from the footprint, it 
will be dragged back to the footprint when you open the PCB again, if you don't need the 
prefix please set the prefix display as No. 



Layer , Net 

CTRL+D 

Layer: You can set a footrpint to be on the TopLayer or BottomLayer, it same as board side. 
*Note: The footprint mirrors when it swapping layers. it doesn't support to mirror at current 
layer.** 

X-Location and Y-Location: Moves the origin of the footprint to a precise position. 

Rotation: Rotates the footprint about its origin over the range from 0o to any angle in 
1o steps (visually of course multiples of 360o will appear identical). 

ID: EasyEDA will assign a unique ID for each footprint automatically, you can't modify it. 

Lock: when locked the object, you can not move it by mouse, but if you set the X Y at the 
right-hand property panel, the object still moves, and the Locked will lock the object layer too. 

Change Attributes in Batch on PCB Editor 

Sometimes, we need to change some attributes of multiple objects together, such as the track 
width, hole size and font size. 

Now, you can select them and do some changes. 

Taking the track for an example. If you select 3 tracks, now you can change their Width , 
together. The difference property values will combine as <...> , change it 

directly will apply to all seleted objects. 
 

 
 

Design Manager 
 

 

Just like Schematic's Design Manager, PCB's Design Manager can be found via: 

Left Navigation panel > Design 

or just press the hotkey to open the Design Manager dialog. 



Design Manager function: 

Filter 

Filter to find a component or net. 

 

 

 

 

 
Jump 

Click the icon to jump to folder. 

 

 

 

 

 
Component 

Click a component/Net/DRC Error to highlight it. 

 

 

 

 

 

 

 

 
Net 



 
 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
DRC 

Click a net to highlight the tracks/vias with the same net. 

 

 

 

 

 

 

 
Click a incomplete net will highlight the ratline and objects. 

 

 

 

 

 

 

 
Check/uncheck the net to show/hide the ratline of the net. 

 

 

 
 
Double click the net to remove all of the tracks and vias with the net name. If you 
want to reroute a net, this is the recommended method to use to un-route it first. 

 



Click the DRC list, will position the DRC mark on the canvas. 

 

 

 

 

 

 

 

 

 
 

Notice: 

Design Manager list doesn't support to refresh automatically, you must click the refresh 
icon manually. 

 
 

Import Changes 
 

 

Import Changes 

Sometimes, while working on a project, you need to make changes to the schematic and then 
update your board, to incorporate them. 

It's easy to do this with EasyEDA. 

Go to the PCB Editor, via: Top Meun > Design > Import Changes 
 

If there are some errors at schematic, such as prefix duplicated, no footprint, it will pop up 
notice dialog, the more information please refer： Schematic - Convert to PCB 

https://docs.easyeda.com/cn/Schematic/Convert-to-PCB/index.html


If no errors, you will get a "Confirm Importing changes information" dialog: 
 

If you are happy with your changes, just click the Apply Change button. 

If you want to update the PCB tracks net same as the schemtiac, you need to enable "Also 
update track's net" option. The editor will update the related track's net depends on the pad's 
net. 

The changes will then be passed into the PCB layout and you can then adjust the tracking to 
suit. 

Notice： 

Because of the net of the schematic is generated after calculating, when you change 
some netlabel, after Import Changes, the PCB track will not be deleted. 
When enable the "Also update track's net" option, after Import Changes, the related 
tracks vias will update the net from the pads, there will be some nets changed isn't you 
want, you need to change them manually, such change prefix, modify the parts 
connection, delete or add part at the schematic, you can change the tracks net via: right- 
click the track - click Select menu - Connection, and them all connection will be seleted, 
you can change them net at the right-hand property panel. 

After Import Changes, there are some action can not be undo. 
 

 

Panelize 
 

 

via: Top Menu - Tools - Panelize 

Panelize by Editor 



At present, EasyEDA only support to panelize PCB itself, in order to decrease the file size, the 
panelized file only panelize the board outline. 
Normally, all the PCB factory will support this panelized file, if you not sure, you need to 
contact your PCB factory support. 

via: Top Menu - Tools - Panelize 

 

The Border height can not less then 3mm. 

 
V- cut: 
If you choose V-Cut, the editor will add the v-cut indication track on Board Outline layer at the 
Gerber. 



 
 

Stamp Hole: 
 

When you preview the Panelize Gerber at JLCPCB.com, you will get the image like below: 



 
 

JLCPCB will take care of your design, they know how to do. 

 

Panelize by Manually 

Process: 

1. Select the whole board, hotkey CTRL+A . 

2. Copy the whole board by reference point, hotkey 

copy and paste the board outline to become the panelize board. 

 

 

 
or CTRL+C . You can only 

3. Paste the board via hotkey 

ratline layer. 
CTRL+SHIFT+V , this hotkey will keep the prefix and hide the 

4. Paste repeatly, after finish, rebuild the copper area with SHIFT+B , recommend draw 

copper area at the end. 

Notice 

If the board contains plane layer, it can not be panelized by manually, it will not generate 
the plane zone as you want. 

 

 

 
 

Layout a PCB Without Schematic 
 

 

CTRL+SHIFT+C 



For some small PCB projects, maybe you don't need a schematic. EasyEDA allows you to lay 
the PCB directly from the PCB Editor. 

1. Start a new PCB 
2. add footprints directly from the Footprints from Left Navigation Panel Library - 

Footprint 

3. and then just route track for them. 

The PCB created by New PCB menu directly, it will hide the ratline layer defaultly. 

For setting pad to pad connections, you can check the above Connect Pad to Pad section. 

 

 

 

 

 

 

 

 

 

PCB Preview 
 

 

2D View 

EasyEDA provide a nice Photo View to help you to check the PCB. 

Via: Top Menu - View - 2D View. 
 

After converting the PCB to Photo View, you can see the result as in the image below. 



 
 

3D View 

After click 3D view menu, the server will generate the 3D view file, when the editor loading 
finish, you will see a pretty cool 3D view. 

 

Change 3D view attributes at the right-hand panel; 
Reset the 3D PCB position at the left-bottom corner icon; 
Keep left-click and drag the canvas can change the view direction; 
Keep right-click and pan can change the 3D PCB position. 

3D model view of the component please check "PCB - 3D Model Manager" and "Footprint - 
Import 3D Model" chapter. 

 

 

  



Experiment no: 16 
 

Experiment Title: 3D modeling in EasyEDA 
syEDA supports for importing 3D models, PCB can view cool 3D models when doing 3D 
preview. Exporting PCB 3D model files is not supported yet. 

 

Open 3D model manager: - tools - 3D model manager 
 

When you open it, you can bind 3D models for Footprint, and you can import or search for 
user-contributed 3D models. Import tutorial please see: Footprint - Import 3D Model 

https://docs.easyeda.com/en/PCBLib/PCB-3DLib-Import/index.html


 
 

1. Click the footprint in the list of footprints on the left, and the preview of footprints will be 
displayed in the central area. Support multiple selection: hold down CTRL + Mouse click 
selection; Hold SHIFT + click select. 

2. Select the imported 3D models from the list on the right or directly search the 3D model 
uploaded by the user, and search by keyword. 

3. Select a 3D library from the list of 3D model libraries and display 2D outline of the top 
view of the 3D model in the middle preview area. 

4. Adjust parameters: 
drag the mouse to align the 2D boundary line with the footprint shape; You can also 
adjust the way you enter parameters below. The right side of the parameters can be 
previewed directly, and it supports a long left - click drag 3D preview interface. 
width/height: the width/height of the 2D shape of the 3D model 
X and Y: the X and Y coordinates of the 2D shape of the 3D model 
z-axis rotation: in the overhead view, the 3D model rotates anticlockwise. The editor 
automatically recognizes the width and height of the footprint and automatically sets the 
z-axis rotation to 90 degrees. 

 
X-axis rotation: in the side view, the 3D model rotates counterclockwise 

 



Y-axis rotation: when facing the image, the 3D model rotates anticlockwise 

 

 

 

 
 

5. After the adjustment, click the "update" button to complete the 3D model binding. 

6. Click 3D preview from the preview menu at the top to preview the 3D model. 

 
 
 

PCB Information 
 

 

PCB design information can be easily obtained by checking PCB information. 

Entry: Top Menu - Fabrication - PCB Information 

 

Nets shows: routed nets/total nets. 

 
 

 
 

PCB Module 
 

 



EasyEDA support create the PCB modules, it seems schematic module. 

How to Create 

Via: Save as Module and File > New > Schematic/PCB Module。 
 

PCB module save at Library > Schematic/PCB module > Work Space > My Libraries 
 

 
How to use 

Since v6.4.3, after placing schematic modules and PCB modules, after Import Changes, 
supports to keep the layout location. 

How to use: 

1. Draw schematic modules and PCB modules, and ensure that their component prefix are 
one to one, and the footprint is also corresponding. The module's component prefix can 
not have question marks and duplicate prefix, such as U? or two R1. 

2. Open schematic and PCB at a same project. 
3. Open "Library", select the module. 

4. Click the "Place" button to place the previous saved schematic module and PCB module. 



5. It will pop up a window to enter English letter. The letter of schematic module should 
keep corresponding with PCB modules. 

 
For example: A component at schematic module is U2, enter letter K, press OK to place 
into canvas, it will be KU2, then PCB module has KU2 too. 
Click "OK" and enter the placement mode. After each placement, the pop-up will 
continue to enter the identification letter. Make sure that the identification letters entered 
each time are unique. 

6. When finish the module place, the PCB component unique ID will same as Schematic 
component unique ID, then after Import Changes, the component's location will be keep. 
and you can update the track's net follow the schematic netlabel too. 

That implement the multipe chanel placing. 

Notice: 

Module composes by tracks and components, it doesn't same as symbol binding 
footprint, the schematic module can not binding PCB module, after placing, the module 
will be separated by many objects, only the symbol and footprint can be corresponding 
via component ID, that is why you need to make the identication letter unique for placing 
each time to make sure schematic module corresponding with PCB module. 

 

 

Generate Fabrication File(Gerber) 
 

 

Generate Fabrication File Gerber 

When you finish your PCB, you can output the Fabrication Files(gerber file) via: File > 
Generate PCB Fabrication File(Gerber) , or Fabrication > PCB Fabrication File(Gerber). 

 

After clicking, will open the Gerber generate dialog: 



 

You can calculate the price for the PCB order, click SAVE to CART will go to JLCPCB and add 
your PCB in the cart. 

Gerber file name 

The generated Gerber file is a compressed zip file. After decompression, you can see the 
following files: 

Gerber_BoardOutlineLayer.GKO: PCB Border file. The PCB board factory cuts the shape 
of the board according to this document. The groove drawn by the EasyEDA, the solid 
region(Type: NPTH) is reflected in the border file after the Gerber is generated. 
Gerber_TopLayer.GTL: Top side copper layer. 
Gerber_BottomLayer.GBL: Bottom side copper layer. 
Gerber_Inner1.G1: Inner copper layer, signal type. 
Gerber_Inner2.GP2: Inner copper layer, plane type 
Gerber_TopSilkLayer.GTO: Top silkscreen. 
Gerber_BottomSilkLayer.GBO: Bottom silkscreen. 
Gerber_TopSolderMaskLayer.GTS: Top solder mask. The default board is covered with 
green oil, and the elements drawn on this layer correspond to the top layer's area will not 
be covered with oil. 
Gerber_BottomSolderMaskLayer.GBS: Bottom solder mask. The default board is 
covered with green oil, and the elements drawn on this layer correspond to the bottom 
layer's area will not be covered with oil. 
Drill_PTH_Through.DRL: Plated drill through hole layer. This document shows the 
location of the hole where the inner wall needs to be metallized. Old name: 
Gerber_Drill_PTH.DRL 
Drill_NPTH_Through.DRL: Non-Plated drill through hole layer. This document shows the 
location of the hole where the inner wall don't need to be metallized. Old name: 
Gerber_Drill_NPTH.DRL 
Gerber_TopPasteMaskLayer.GTP: Top Paste Mask, for the stencil. 
Gerber_BottomPasteMaskLayer.GBP: Bottom Paste Mask, for the stencil. 
Gerber_TopAssemblyLayer.GTA:Top Assembly, read only, doesn't affect the PCB 
manufacture. Old name: ReadOnly.TopAssembly 



Gerber_BottomAssemblyLayer.GBA: Bottom Assembly, read only, doesn't affect the PCB 
manufacture. Old name: ReadOnly.BottomAssembly 
Gerber_MechanicalLayer.GML: Record the information on the mechanical layer in the 
PCB design, and only use it for information recording. Old name: ReadOnly.Mechanical. 
By default, the shape of the layer is not manufactured at the time of production. Some 
board manufacturers use the mechanical layer to make the frame when using Altium file 
to production. When using Gerber file, it is only used for text identification in JLCPCB. For 
example: process parameters; V cut path etc. In EasyEDA, this layer does not affect the 
shape of the border of the board. If the mechanical layer has closed wires, JLCPCB will 
give priority to using the mechanical layer as the shape of the board when producing the 
board. If there is no outer frame of the mechanical layer, GKO will be used as the frame 
(historical influence of Altium file). It is necessary to pay attention to the use of the 
mechanical layer in the design. 

Notice: 
 

Before ordering the PCB, please check the gerber at the Gerber view as below. 
The Gerber files are generated by browser, please use the browser inner downloader to 
download! 
The coordinates of the Gerber file follow the canvas coordinates 
When exporting Gerber, the coordinate format accuracy defaults to 3:3. When the PCB 
size is out of range, it automatically uses 4:2 format. If you view the Gerber as such as 
CAM350, found that the Drill hole has been offset the location, you can modify the drill 
coordinate format to fit the location 

Gerber View 

Before sending Gerber to the factory, please use gerber viewer to check the Gerber carefully. 

local gerber viewer you can use such as: Gerbv, FlatCAM, CAM350, ViewMate, GerberLogix etc. 

Gerber viewer recommend Gerbv: 

Project page:http://gerbv.geda-project.org/ 

Download: https://sourceforge.net/projects/gerbv/files/ 

How to use Gerbv: 

1. Download Gerber zip file, and download Gerbv, unzip Gerber file and run the Gerbv; 

http://gerbv.geda-project.org/
https://sourceforge.net/projects/gerbv/files/latest/download?source=files


+ 2. Click the button at the Gerbv dialog bottom-left corner, open the gerber folder, select all 

the gerber files, and open. 

 

 

 

 

 

 

 

 

 

 
 

3. And then zoom, measure, check every layer, check drill holes and location. etc. 

FlatCAM is a nice tool too: http://flatcam.org/ 

FlatCAM lets you take your designs to a CNC router. You can open Gerber, Excellon or G-code, 
edit it or create from scatch, and output G-Code. Isolation routing is one of many tasks that 
FlatCAM is perfect for. It's is open source, written in Python and runs smoothly on most 
platforms. 

Free Online Gerber Viewer: 

Recommend： 
jlcpcb.com 
tracespace.io/view 
gerber.ucamco.com 

 
 

 
 

Export BOM 
 

 

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB, via: "Top 
Menu - File - Export BOM", or "Top Menu - Fabriaction - BOM". 

 

After clicking the BOM export option, the dialog below will open. 

http://flatcam.org/download
https://jlcpcb.com/quote
https://tracespace.io/view/
https://gerber.ucamco.com/


In this dialog，you can click the buttom to assign LCSC part's order code for your 
components. 

 

After clicking on the assign icon，the components and footprints search dialog will pop up, 
and you can choose which component you want to assign. 

 

When you click the "Order Parts/Check Stock" button, we will help you to list all the 
components of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If 
you want to buy the components form LCSC, and you just need to put them to the cart and 
check out. 



 

You can open the BOM in any text editor or spreadsheet. 
 

Export BOM supports to export LCSC part price, it is the same as LCSC website. 

Notice: 

Before v6.4.17, If your project has schematic and PCB, the BOM data will come from 
schematic; if the project only has PCB, the BOM data will come from PCB. 
Since v6.4.17, the schematic BOM and PCB BOM are separated. If you assign the LCSC 
part at the PCB, it will not modify the schematic. 
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or 
PCB manufacturer, please convert the encoding and change the delimiter. 
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV 
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv). 
You can also open the CSV file with any text editor (such as Windows Notepad) and save 
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas. 

 
 
 

Export Pick and Place File 
 

 



In PCB editor, if you want to generate Pick And Place as a CSV file, you can via: 

File > Export Pick and Place File or Top Menu - Fabrication - Pick and Place File. 

You can set the options: 

 

 

 

 

 

 
 
If your PCB has been panelize by the editor, you can enable the "Include panelized 
components coordinate". 

When you open the exported CSV file, you can see: 

 

 

 

 
This file support two units "mm" and "mil", it is following the PCB unit setting. 

There is an option "Mirror the coordinates of the components on the bottom side(Some SMT 
manufacturer may need it, while JLCPCB does not)", you can check with your SMT 
manufacturer, the mostly SMT manufacturer doesn't need it. 

Notice： 

In order to support multiple languages, BOM and Pick and Place files (CSV file) are 
UNICODE encoded and tab-based. If the CSV file cannot be read by your components 
vendor or PCB manufacturer, please convert the encoding and change the delimiter. 



Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV 
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv). 
You can also open the CSV file with any text editor (such as Windows Notepad) and save 
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas. 

 
 

 
 

Export DXF 
 

 

EasyEDA support to export PCB to DXF. 

At present EasyEDA supports to export a full layers and objects DXF file: 
 

You can edit it at CAD tools very easy, toggle the layers as you want. 
 

 

How to Order PCB 
 

 

Order Parts 

1. Finish the schematic and PCB design at EasyEDA. 
2. Open schematic, click " - Export BOM" button, the BOM dialog will open, click "Order 

Parts/Check Stock" button, will open LCSC.com order page. Check Export BOM 

3. Add the parts to the cart, and then submit the payment. 

Order PCB 

1. Open PCB, click " - Generate Fabriaction File(Gerber)". Check Generate Fabrication  
File(Gerber) 

2. Before ordering, check the Gerber first: Gerber Viewer 

3. Visit at JLPCB https://jlcpcb.com/quote ,login with EasyEDA accout. 

https://lcsc.com/
https://docs.easyeda.com/en/Schematic/Export-BOM/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html#Gerber-View
https://jlcpcb.com/quote


4. Order PCB from EasyEDA editor directly(at Generate) or you can add the Gerber 
file(compressed file, ZIP) on the page and type the order options. 

5. If you want to assembly parts, before enable the SMT option, you need to check all your 
parts are using "LCSC Assembled" class libs, and then upload the BOM file and Pick and 
Place file. 

LCSC Assembled Libraries 
Export BOM 
Generate Fabrication File(Gerber) 

6. Save to the Cart, and then submit the payment. 

Doesn't support to combine the components order with the PCB order. 

More information please refer at: 

How to place an order 

How to order a SMT order 

How to order a stencil 

  

https://docs.easyeda.com/en/Schematic/Libraries/index.html#Libraries
https://docs.easyeda.com/en/Schematic/Export-BOM/index.html
https://docs.easyeda.com/en/PCB/Gerber-Generate/index.html
https://support.jlcpcb.com/article/21-how-do-i-place-an-order
https://jlcpcb.com/smt-assembly
https://support.jlcpcb.com/article/25-how-to-order-a-stencil


Experiment no: 17 
 

Experiment Title: Create The Footprint in EasyEDA 
 

 

Create The Footprint 

There will be times when you will need a PCB footprint that is not already in the EasyEDA 
libraries. 

Footprint Tool 

The process of creating your own Footprints is very similar to how you make symbols for your 
own Schematic Libs. 

Footprint Tools almost are the same as PCB tools, just lacking some of the functions. 
 

Create Footprint 

Start a new Footprint as shown below or by doing: 

File > New > Footprint



 

This opens the New Footprint editor. 

Drawing Steps 

1. Downlod the datasheet which you need to draw the Footprint, such as SOIC-8.Such as PDF： 
UC2844BD1R2G 

2. Read the datasheet, notice the 0 degree of the Footprint (The 0 degree is the Footprint's 
direction when you placed it on the PCB without rotation), the right 0 degree will helpful for 
PCB SMT. 

3. Check the footprint size, pad/pin direction and polarity, and then place the Pads on the 
canvas. You can adjust the pad size base on your real usage situation. 

Component's pin direction, page 1. 

 

https://image.easyeda.com/files/ON-Semicon-ON-UC2844BD1R2G_C77262.pdf
https://image.easyeda.com/files/ON-Semicon-ON-UC2844BD1R2G_C77262.pdf


footprint polarity, page 1 and 18. 

 

 

Depends on page 18, placing one pad on the canvas on the top layer, and then change 
the pad number, size, shape type etc. And then set the coordinate for it, and place the 
less pads, you can use the "Top Menu - Align" tools to align the pads to fit the location. If 
you want to move the pad by mouse or direction key by small steps, you can set a new 
snap size at the right-hand panel. 

 

4. Drawing the Footprint silk screen. And sometimes you can add some marking and text on 
the mechanical or document layer. 

Swicthing layer to TopSlikLayer 
Using the Track and Arc to draw the silk screen. The editor doesn't support draw the 
retangle silk screen at present. 

 



5. Filling the footprint title and prefix at the right-hand "Custom Attributes", and then Save. 
When you save it , please fill the tags, description, the description suggesting add the 
footprint datasheet link and footprint size, that can help you or other people to recognize this 
Footprint whether if it can be used for the design. 

 

6. Use the dimension tool to check the Footprint size, via: Top Menu - Tools - Check 
Dimension. 

7. Set the origin. You can via: "Top Menu - Place - Set Canvas Origin - By Center of Pads" to set 
the origin. 

8.Save. 

Then the PCB footprint creating finish . 

Notice： 

The Origin Point. To simplify rotating your symbols when they are placed into the canvas, 
make sure all of your symbols are created as near as possible centered around that point. 
Suggesting the footprint center to be the origin point. That will helpful to rotation when 
you placing it on the canvas, and help to do the SMT more quickly. 
The pad center suggesting one and more on the grid , avoid when place it on the PCB 
causing the track hard to connect issue. 
The pad number can be set as number and alphabet, they must match with the 
SchematicLib's pin number, otherwise the component which was assigned this Footprint 
will alert the error at the footprint manager, and can' not convert the schematic to PCB. 
The pad number will increase by placing with mouse, if you copy and paste it, the 
number will not increase. 

Others 

It is important to set the right Snap and Grid sizes to ensure that the pads on the finished 
footprint snap exactly to the grid and so connect the nets. For example, if you 

are creating a DIP footprint, set the Grid size to 100mil. 

Keep all other shapes such as component outlines and any associated pin identification 
marks or text on the TopSilkLayer. EasyEDA will automatically take care of the actual 
layer assignment when you place the footprint on the PCB. 



CTRL+S 

P 

Round Rectangular OVAL 

to save your footprint designs and you will find them saved into the Libraries > 
Classes: Footprint > Personal > Created section of the left Navigation panel. 

Annular ring of the pad/via is too small, keep the annular ring >= 4mil. In this case, you 

 
 

Pad attributes 

You can add pads using the Pads button from the Footprint Tools palette or using the 
hotkey. 

After selecting one of the pads, you can view and adjust its attributes in the right hand 
Properties panel. 

 

Number: Remembering the pin numbers you set in the schematic symbol in your Schematic 
symbol: to connect those schematic symbol pins to the pads in your PCB footprint, the 

pad numbers you set here in the Footprint footprint must be the same. 

Shape: Round , Rectangular , Oval and Polygon. 

EasyEDA supports four shapes: , , and POLYGON . 

PAD will give your more space. 

PAD will let you to create some strange pad. 

can add a Hole 

OVAL 

POLYGON 



 

Layer: If the pads are part of a SMD footprint, you can set it to Top layer or Bottom layer. 
For through hole components you should set it to Multi-Layer. 

Net: You don't need to enter anything here because at present this footprint is not connected 
to anything in a circuit. 

Width and Height: When the shape is set to Round, Width will equal Height. 

Rotation: Here you can set the Pad's rotation as you want. 

Hole(D):  This is the drill hole diameter for a through hole pad. For a SMD Pad, set this to 

zero. 

Center-X and Center-Y: using these two attributes, you can set the pad's position with more 
precision, compared to using the mouse. 

Plated： Yes or No. when the pad is multi-layer pad, if it set the plated as no, this pad top side 
and bottom side will not be connected together. 

 
 
 

Edit Footprints 
 

 

Edit Footprint in Library 

When you found a Footprints(footprint) but it can not be satisfied for your design, you can 
edit it to be your personal PCB footprint. 

Via Library > Footprint > Search Component/Personal/LCSC/System > Select footprint > 
Edit 

Like in the image below, you can edit the PADs points when you select a POLYGON PAD 



 

You can edit the pad size, shape outlines, etc. when you finish and save, it will be saved to 
your personal libraries "Created" and become your personal libraries. 

 

And you can add a tag for your Footprint when you save it: 

 

 

 

 

 

 

 

 

 

 

 
 
Modify the saved Footprint tag at "Library" part list. 



Edit Footprint in PCB 

If you want to edit a package(footprint) in the PCB, you can use the Ungroup/Group function 
same as the schematic. 

On the PCB Tools palette there is the Group/Ungroup Symbol… button. 
 

This tool is for you to quickly create or edit library symbols. 

1. Select a footprint 
2. Click the Group/Ungroup Symbol… button 

Up to this point you have a collection of separate pads, a drawn silk layer tracks and 
some text that are all separate items with no particular association with each other. 

3. Edit the shape or pad what you want to change 

4. Select all of the items and click the Group/Ungroup Symbol… button. 

A dialog will be opened: 
 

After you click OK, all those separate elements will be grouped together to form your new 
symbol directly in the PCB. 

Using the group function, you can create/edit any symbol in the Schematic/PCB, easily and 
quickly. 

Notice: 

Before ungroup the footprint, please change it's layer to top layer first, because of the 
footprint after grouping will at top layer. 

 

 

Import PCB 3DLib 
 

 

Import 3D File 

EasyEDA supports for importing 3D models, PCB can view cool 3D models when doing 3D 
preview. Exporting PCB 3D model files is not supported yet. 



 
 

1. Draw or download 3D model 

Note: currently only 3D models in "WRL(VRML)" and "obj" are supported. WRL can be 
imported directly without the need for compression; Obj must be compressed into a zip file 
with the "mtl" file and then imported, and the "mtl" file is usually taken with you when you 
download the obj file. Other formats of 3D files wii be supported in the future. 

Note that file suffixes cannot be capitalized. 

Download address: 

https://library.io/explore/3dmodels ("mtl" files are automatically downloaded when obj files 
are downloaded.) 

https://github.com/KiCad/kicad-packages3D 

https://www.traceparts.com/zh 

https://www.3dcontentcentral.com/ 

https://grabcad.com/ 

2. Create a new 3D library 

in "Top Meun - New - PCB 3D Lib". 
 

https://library.io/explore/3dmodels
https://github.com/KiCad/kicad-packages3D
https://www.traceparts.com/zh
https://www.3dcontentcentral.com/
https://grabcad.com/


If you have many 3D libraries, you can zip them to a zip file to import, no more than 10 WRL 
files for one zip file, otherwise it will fail to import. 

OBJ format contains many 3D models in one file, you don't need to zip them. 

If your WRL file cannot import directly, please use FreeCAD to export a new one and try again. 

3. Import 3D model. 

You can check which 3D model you want to import. 
 

4. Specify the 3D model 

Open the PCB or Footprint, and find " - Tools - 3D Model Manager" 
 

Specify the imported 3D model for the corresponding footprint, which is basically 
consistent with the footprint manager operation. For the specific use of the tutorial, 



please see: PCB - 3D Model Manager 

 

 

 

 

 

 

 

 

 

 
 

Adjust the position and parameter relationship between the 3D model and PCB 
packaging, and click update 
After completing all the specified 3D models, you can start the 3D preview of the whole 
PCB. 

Edit 3D Lib 

1. The SHIFT+F shortcut opens the component library dialog box 
2. Switch to "PCB 3D library" and "WorkSpace" 

3. Right click can edit and delete 3D library 
 

FAQ： 

Q：Can the official footprint library specify the 3D model first? 
A：Yes, later official libraries will specify 3D models. At present, you need to specify to PCB or 
PCB footprint. 

Q：Can EasyEDA export the whole PCB 3D format for structural design? Step, etc. 
A：It will be supported in the future, step by step, and will directly support importing the step 
format in the future. This format is more complicated and needs time to study. 

https://docs.easyeda.com/en/PCB/3D-Model-Manager/index.html


Q：Will EasyEDA support to draw 3D models in the future? 
A：Don't. At present, many 3D rendering tools are very mature (Auto CAD, CAXA, SolidWorks, 
etc.) or open source free (FreeCAD, LibreCAD). Online 3D design tools (onshape) are also 
available. 

 
 
 

Footprint Naming Rule 
 

 

EasyEDA Footprint Naming Rule 

EasyEDA Footprint Naming Rule Reference 

Introduction: 

Believe that the vast number of electronic engineers will encounter the problem of footprint 
name naming, and now EasyEDA to provide everyone with a reference scheme - "EasyEDA 
Footprint Naming Rule Reference". 

Each company should have its own footprint naming specification,EasyEDA is no exception, 
EasyEDA has more than 180,000 of official library (LCSC library), multiple engineers in the 
construction of footprint, more need unified library rules and footprint naming rules to ensure 
library consistency and footprint reuse. 

Written by LCSC engineering department and EasyEDA team, after close one year of running 
in, now we are very happy to release the "EasyEDA Footprint Naming Rule Reference". 

EasyEDA has been established according to the new footprint naming specification Footprints 
for more than half a year, and EasyEDA will continue to draw new library according to this rule. 



 
 

The majority of EasyEDA users can also according to this rule: 

1. Find the components of the specified package type; 
2. Create your own or team's or company's footprint according to this rule; 

3. Quickly reuse the official footprint. 

Characteristics: 

1. The rules of "package type _ feet number - body width - foot distance - body length - 
foot azimuth - polarity direction _ series name" are adopted in naming, so that users can 
quickly and clearly footprint most of the information 

2. It covers most common component classification and encapsulation types and can 
quickly locate and query 

3. Continuously expand new naming rules according to new components or packaging 
types, and continuously update and maintain 

4. Public distribution, free of charge for both individuals and enterprises 

Disadvantages: 

Titles of some footprint types are too long 

Update record: 

2019.12.27 First release 

Download: 

Download: EasyEDA Footprint Naming Rule Reference.pdf 

https://easyeda.com/forum/topic/EasyEDA-Footprint-Naming-Rule-Reference-9b470b52aeca46228b446f1fc0e323f0


Experiment no: 18 
 

Import Image 
 

 

Import Image to Schematic 

When you select Image from the Drawing Tools palette, an image place holder will be inserted 
into the canvas: 

 

Select the place holder, so you can see the image's attributes in the right hand Properties 
panel: 

 

Set the URL of your image. For example, setting the URL to: 

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-  
555_Pinout.svg.png 

will make your image look like this: 
 

Please note: at present, EasyEDA does not host images, so you need to upload your images to 
an image sharing site such as http://www.imgur.com. 

http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png
http://upload.wikimedia.org/wikipedia/commons/thumb/c/c7/555_Pinout.svg/220px-555_Pinout.svg.png
http://www.imgur.com/


Import Image to PCB 

In the PCB and Footprint editor there is a nice feature on the PCB Tools bar. 
 

After clicking on the image icon you will see the Insert Image window as shown below. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
In this dialog, you can choose your favorite image, EasyEDA support JPG , BMP , PNG , GIF , and 
SVG . Unlike some other EDA tools which only support a Monochrome Bitmap image, EasyEDA 
supports full color, but Monochrome Bitmap is welcome. 

You can adjust the color tolerance, simplify levels and reset the image size there. 

You can also select shape invert. 



The image will be inserted to the active layer, if it is not right, you can change an attribute, 
such as TopSilkLayer. 

 

Import DXF File 
 

 

 
How can you create irregular board outlines or complex board outline in EasyEDA? 
This is sometimes needed when you are designing a PCB for an enclosure that may have a 
curved profile, or other unavoidable mechanical features that must be accounted for in the 
design. 

EasyEDA supports importing DXF into PCB. 

Find the import DXF menu under the file menu. Use: File - Import - DXF 
 

After selecting the *.DXF file, you will find a dialog as shown below 



 
 

EasyEDA provides some options, units(mm, cm, mil, inch), and selecting the layer to which the 
shapes will be applied. 

When importing DXF into schematic or symbols, the units are pixels. 

After clicking the import button, you will find them on your PCB canvas. 



 
 

You can try this to import this example by yourself. DXF example 

Please note: 

1. The file must have a *.dxf filename extension. 
2. The circles will be converted to holes if you choose the layer as board outline. 
3. There are some items which are not supported, such as Mirror, spiral line etc. 
4. If the DXF objects were grouped, please ungroup them before importing. 
5. Do not import a large DXF to copper layer directly, it will be very slow and appear to be 

hung in the editor. 
 

 

Import Altium Designer 
 

 

The import function is in beta now, please check your design carefully after importing. 

Some design rules are not yet supported by EasyEDA. 

Import Schematic and PCB 

1. You can import Altium Designer's Schematic and PCB files into EasyEDA but the format 
must be ASCII files, so you need to save the designs as Ascii files like this. 

Schematic saved as "Advanced Schematic ascii (*.SchDoc)" 

PCB save as "PCB ASCII File (*.PcbDoc)" 

https://image.easyeda.com/files/test.dxf


 
 

Then import it using: File - Open - Altium... 
 

 
EasyEDA offers an excellent experience in importing Altium Designer's Schematic and PCB as 
you can see from the image below of a schematic imported from Altium Designer: 



 
 

If your schematic and PCB are Protel 99se format files, please open in Altium Designer and 
save as ASCII format, and then import them. EasyEDA does not support Protel 99se file format 
directly. 

2. If you import Altium schematic and some text becomes unreadable, please encode your 
ASCII file with UTF-8. 

Notice: 

EasyEDA does not currently support importing Altium PCB rules. 
EasyEDA does not currently support importing Altium PCB inner layers, please modify 
manually after imported. 

EasyEDA does not currently support importing the Altium IEEE symbol in the schematic. 

 

 

 

 

 

 

 

 
Please do not export your design to Altium and then import it again as this may cause 
some details to be lost!!! 
If the Altium file is large it may take a long time to import, removing the copper layer 
before importing can improve the speed. 
Importing the border processing logic of AD file: The Board Shape turns into a border 
layer, keep-out turns into a document layer, and Mechanical becomes a mechanical layer. 



Extract 

Libs 

Import Altium libraries 

Altium Designer's Schematic and Footprint libraries are not available as ASCII files, EasyEDA 
can't import them directly, so how can you import them? 

In the Import file from your computer dialog to the right of File Operation; tick the 
option and EasyEDA will extract all the libs from the Schematic files or PCB Files. 

So, if you want to import Altium Designer's Libs, you can add them to your Altium Designer 
Schematic or PCB and then extract them again into your EasyEDA library. 

 

Import Eagle 

Please refer next section 

Import KiCAD 

Please refer next section 
 

 

Import Eagle 
 

 

Eagle Schematic/PCB/libs can be imported, but EasyEDA only supports version 6 and later (6+) 
because that was when Version 6 Eagle adopted an ASCII XML data structure as their native 
file format. 



 
 

If your Eagle file can be opened in Eagle, but fails import to EasyEDA, save a copy with the 
latest Eagle, and then import that one. 

If your file has been saved as a copy from v6.0 or greater, but importing still fails, then edit the 
Eagle file with a Text Editor. Search the file for garbled characters (something that looks 
strange), remove them, and try again. 

If your schematic needs to update the PCB, please use the "Import File and Extract Libs" 
option, make sure that all libraries are imported first. 

Some rules or primitives are not supported, please check carefully after importing to make 
sure the design is correct. 

 
 
 

Import KiCAD 
 

 

EasyEDA supports importing KiCAD v4.06 and greater version KiCAD files, if the KiCAD files 
version is less than v4.06, please open them with the latest KiCAD and save as a new one, and 
then import them. 

The KiCAD project files need to be compressed as zip file before importing. 



 

If you only want to import the PCB, you just need to ZIP the PCB file and then import it. 
If you want to import the schematic, you must ZIP the schematic and symbols together, 
we suggest using the KiCAD archive tool when opening the project in KiCAD, it will 
include the symbols in the ZIP file automatically. 

 

Notice 

For the KiCAD special symbols such as Power symbol (Power Flag(PWR_FLAG)), EasyEDA 
will convert them as the symbol not Netflag, you can delete them if you don't need them. 
The PCB design rule is not supported yet. 
KiCAD has updated the document format since KiCad v5.1.3, if the import fails, please try 
a previous version. A fix for this is being developed. 

  



Experiment no: 19 
 

Experiment Title: Export Schematics 
 

 

Export Schematics in PDF/PNG/SVG 

Use: ** > File > Export > PDF/PNG/SVG…** 

 
 

will open this dialog: 



 

Export to: This allows you to export your design to SVG, PNG and PDF file format. 

Size: Only for PNG and SVG. This is the width of the image, for example, when you set 
size as 1x, the exported PNG's width is 600 pixels. If you set the size as 2x the width will 
be 1200 pixels in the exported PNG. 

Wire Width: If you set this to 2x, the line width will be enlarged two times. This is 
illustrated in the image below. 

 
Engine: 

Local: PDF generated by Editor 
Cloud: PDF generated by the Cloud Server, this feature will likely soon be removed 
from EasyEDA. 

Type: 

Merged sheet: If your schematic has multiple sheets it will be merged into one file. 
Separated sheet: If your schematic has multiple sheets each sheet will be created in 
a separate file. 

 



.schdoc 

Export Schematics in Altium Designer Format 

EasyEDA supports exporting the schematics in Altium Designer format. 
Use "File > Export > Altium...", and click the "Download now". A 
created. 

 

The more information please refer to Export Altium 

Download Schematics 

Please refer to Export EasyEDA Source

 
file will be 

https://docs.easyeda.com/en/Export/Export-Altium/index.html
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html


Print Schematic 

The command File > Print, will open a web page with the print dialog which is used to print 
the schematic. 

If you are using EasyEDA Client you need to take note of the edge of the sheet, if it is past the 
page edge it is recommended to export to PDF and print. 

If you are using Chrome, you will need to adjust the print options to fit to the page size and 
disable the option for "Headers and footers". Without this the A4 size will print an extra page. 

 

 

 

 
 

Export BOM 
 

 

You can export the Bill of Materials (BOM) for the schematic (Document) and PCB, via: "Top 
Menu - File - Export BOM", or "Top Menu - Fabriaction - BOM". 

 

After clicking the BOM export option, the dialog below will open. 

In this dialog，you can click the buttom to assign LCSC part's order code for your 
components. 

 

After clicking on the assign icon，the components and footprints search dialog will pop up, 
and you can choose which component you want to assign. 



 

When you click the "Order Parts/Check Stock" button, we will help you to list all the 
components of your BOM at LCSC.com(If you haven't login LCSC, you have to login first). If 
you want to buy the components form LCSC, and you just need to put them to the cart and 
check out. 

 

You can open the BOM in any text editor or spreadsheet. 



 
 

Export BOM supports to export LCSC part price, it is the same as LCSC website. 

Notice: 

Before v6.4.17, If your project has schematic and PCB, the BOM data will come from 
schematic; if the project only has PCB, the BOM data will come from PCB. 
Since v6.4.17, the schematic BOM and PCB BOM are separated. If you assign the LCSC 
part at the PCB, it will not modify the schematic. 
In order to support multiple languages, BOM and coordinate files (CSV file) are UNICODE 
encoded and tab-based. If the CSV file cannot be read by your components vendor or 
PCB manufacturer, please convert the encoding and change the delimiter. 
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV 
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv). 
You can also open the CSV file with any text editor (such as Windows Notepad) and save 
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas. 

 
 
 

Export NetList 
 

 

EasyEDA can export the netlist for the whole active project: 

File > Export NetList > Spice... 



 

EasyEDA can export a netlist in a variety of formats: 

LTSpice for this Sheet: this is a Spice compatible netlist generated by the simulation 
engine of EasyEDA, It is not normally used as the basis for as a PCB layout. 
Protel/Altium for PCB: a PCB netlist in a format that can be imported straight into 
Altium Designer and it's predecessor, Protel. 
PADS for PCB: a PCB netlist in a format that can be imported straight into Pads PCB 
layout tools. 
FreePCB for PCB: a PCB netlist in a format that can be imported straight into FreePCB, a 
free, open source PCB editor for Windows. 

 
 
 

Export PCB 
 

 

Export PCB in PDF/PNG/SVG 

Exporting a PCB design or footprint from EasyEDA is very similar to exporting a Schematic or a 
Symbol. 

Use: File > Export > PDF/PNG/SVG… 



 
 

This dialog will open: 
 



You can choose to export in PDF, PNG or SVG format. 

Note: *The PDF size is zoom as 1:1 with PCB. * 

Export to: Support export to PDF, PNG, SVG. To print the PCB as 1:1 you should choose 
PDF. 

Engine: 

Local: PDF generated by Editor 
Cloud: PDF generated by Cloud Server, this feature is planned to be removed in the 
future. 

Graphics: 

Full Graphics: All graphics and objects will be exported. 

 

 

 

 

 

 

 

 

 

 
Assembly Drawings: This exports only component prefixes, locations, holes, etc. 
This is used for parts assembly. 

 
Object Outline: This only exports the objects outlines, such as Pad and silkscreen 
outlines. 



 
Type: 

Merged layer: All selected layers will be merged into one page. 

Paged layer: All selected layers will be separate pages in a single file. 
Separated layer: All selected layers will be exported into separate files contained in 
a ZIP file. 

Color: You can choose "Black on White", "White on Black", "Full Color". 

Layer: You can select to print individual layers or selected layers merged into a single file. 

Mirror: It is also possible to mirror selected layers so that the bottom layers are shown in 
easily readable orientation. This is recommended when all your selected layers are 
bottom ones. 

If EasyEDA PDF does not satisfy your requirements, please let us know. 
 

 
If you generated the Gerber file, you can use the Gerbv application to easily export the PDF 
file. 

Use: Gerbv 

 

Export PCB in Altium Designer Format 

The more information please refer at Export Altium 

Download PCB 

Please refer to Export EasyEDA Source 

Print PCB and Etching 

EasyEDA doesn't support directly printing the PCB, instead export to PDF and then print. 

If you don't want to order your PCBs from EasyEDA then maybe - for single and double sided 
PCB designs - you can try using some homemade PCB tech: 

http://hackaday.com/2012/12/10/10-ways-to-etch-pcbs-at-home/ 

https://docs.easyeda.com/en/Export/Export-Gerber-Files/index.html#Gerber-View
https://docs.easyeda.com/en/Export/Export-Altium/index.html
https://docs.easyeda.com/en/Export/Export-EasyEDA-Source-File/index.html
http://hackaday.com/2012/12/10/10-ways-to-etch-pcbs-at-home/


So, here's how you can print your PCB layer by layer and then etch it onto a PCB. 

Step 1) Export it to PDF, Using: File > Export > PDF… 

Note: Make sure the Colour is Black on White Background. 

For the bottom layer, select the mirror option on export if needed. 

If you have routed PCB tracks on the top layer you will also need to export that layer. Etched 
PCBs generally need to use the mirror export printing option. 

Step 2) Open the pdf file in a viewer 



 
 

Step 3) Print it to paper 
 

Step 4) Copy it to the copper 
 

Step 5) Etch it 

Step 6) Drill it 



 
 

Step 7) Get your soldering iron out! 
 

 
 

Generate Fabrication File(Gerber) 
 

 

Generate Fabrication File Gerber 

When you finish your PCB, you can output the Fabrication Files(gerber file) via: File > 
Generate PCB Fabrication File(Gerber) , or Fabrication > PCB Fabrication File(Gerber). 

 



After clicking, will open the Gerber generate dialog: 
 

You can calculate the price for the PCB order, click SAVE to CART will go to JLCPCB and add 
your PCB in the cart. 

Gerber file name 

The generated Gerber file is a compressed zip file. After decompression, you can see the 
following files: 

Gerber_BoardOutlineLayer.GKO: PCB Border file. The PCB board factory cuts the shape 
of the board according to this document. The groove drawn by the EasyEDA, the solid 
region(Type: NPTH) is reflected in the border file after the Gerber is generated. 
Gerber_TopLayer.GTL: Top side copper layer. 
Gerber_BottomLayer.GBL: Bottom side copper layer. 
Gerber_Inner1.G1: Inner copper layer, signal type. 
Gerber_Inner2.GP2: Inner copper layer, plane type 
Gerber_TopSilkLayer.GTO: Top silkscreen. 
Gerber_BottomSilkLayer.GBO: Bottom silkscreen. 
Gerber_TopSolderMaskLayer.GTS: Top solder mask. The default board is covered with 
green oil, and the elements drawn on this layer correspond to the top layer's area will not 
be covered with oil. 
Gerber_BottomSolderMaskLayer.GBS: Bottom solder mask. The default board is 
covered with green oil, and the elements drawn on this layer correspond to the bottom 
layer's area will not be covered with oil. 
Drill_PTH_Through.DRL: Plated drill through hole layer. This document shows the 
location of the hole where the inner wall needs to be metallized. Old name: 
Gerber_Drill_PTH.DRL 
Drill_NPTH_Through.DRL: Non-Plated drill through hole layer. This document shows the 
location of the hole where the inner wall don't need to be metallized. Old name: 
Gerber_Drill_NPTH.DRL 
Gerber_TopPasteMaskLayer.GTP: Top Paste Mask, for the stencil. 

Gerber_BottomPasteMaskLayer.GBP: Bottom Paste Mask, for the stencil. 



Gerber_TopAssemblyLayer.GTA:Top Assembly, read only, doesn't affect the PCB 
manufacture. Old name: ReadOnly.TopAssembly 
Gerber_BottomAssemblyLayer.GBA: Bottom Assembly, read only, doesn't affect the PCB 
manufacture. Old name: ReadOnly.BottomAssembly 
Gerber_MechanicalLayer.GML: Record the information on the mechanical layer in the 
PCB design, and only use it for information recording. Old name: ReadOnly.Mechanical. 
By default, the shape of the layer is not manufactured at the time of production. Some 
board manufacturers use the mechanical layer to make the frame when using Altium file 
to production. When using Gerber file, it is only used for text identification in JLCPCB. For 
example: process parameters; V cut path etc. In EasyEDA, this layer does not affect the 
shape of the border of the board. If the mechanical layer has closed wires, JLCPCB will 
give priority to using the mechanical layer as the shape of the board when producing the 
board. If there is no outer frame of the mechanical layer, GKO will be used as the frame 
(historical influence of Altium file). It is necessary to pay attention to the use of the 
mechanical layer in the design. 

Notice: 
 

Before ordering the PCB, please check the gerber at the Gerber view as below. 
The Gerber files are generated by browser, please use the browser inner downloader to 
download! 
The coordinates of the Gerber file follow the canvas coordinates 
When exporting Gerber, the coordinate format accuracy defaults to 3:3. When the PCB 
size is out of range, it automatically uses 4:2 format. If you view the Gerber as such as 
CAM350, found that the Drill hole has been offset the location, you can modify the drill 
coordinate format to fit the location 

Gerber View 

Before sending Gerber to the factory, please use gerber viewer to check the Gerber carefully. 

local gerber viewer you can use such as: Gerbv, FlatCAM, CAM350, ViewMate, GerberLogix etc. 

Gerber viewer recommend Gerbv: 

Project page:http://gerbv.geda-project.org/ 

Download: https://sourceforge.net/projects/gerbv/files/ 

How to use Gerbv: 

1. Download Gerber zip file, and download Gerbv, unzip Gerber file and run the Gerbv; 

http://gerbv.geda-project.org/
https://sourceforge.net/projects/gerbv/files/latest/download?source=files


+ 2. Click the button at the Gerbv dialog bottom-left corner, open the gerber folder, select all 

the gerber files, and open. 

 

 

 

 

 

 

 

 

 

 
 

3. And then zoom, measure, check every layer, check drill holes and location. etc. 

FlatCAM is a nice tool too: http://flatcam.org/ 

FlatCAM lets you take your designs to a CNC router. You can open Gerber, Excellon or G-code, 
edit it or create from scatch, and output G-Code. Isolation routing is one of many tasks that 
FlatCAM is perfect for. It's is open source, written in Python and runs smoothly on most 
platforms. 

Free Online Gerber Viewer: 

Recommend： 
jlcpcb.com 
tracespace.io/view 
gerber.ucamco.com 

 
 

 
 

Export Pick and Place File 
 

 

In PCB editor, if you want to generate Pick And Place as a CSV file, you can via: 

http://flatcam.org/download
https://jlcpcb.com/quote
https://tracespace.io/view/
https://gerber.ucamco.com/


File > Export Pick and Place File or Top Menu - Fabrication - Pick and Place File. 

You can set the options: 

 

 

 

 

 

 
 
If your PCB has been panelize by the editor, you can enable the "Include panelized 
components coordinate". 

When you open the exported CSV file, you can see: 

 

 

 

 
This file support two units "mm" and "mil", it is following the PCB unit setting. 

There is an option "Mirror the coordinates of the components on the bottom side(Some SMT 
manufacturer may need it, while JLCPCB does not)", you can check with your SMT 
manufacturer, the mostly SMT manufacturer doesn't need it. 

Notice： 

In order to support multiple languages, BOM and Pick and Place files (CSV file) are 
UNICODE encoded and tab-based. If the CSV file cannot be read by your components 
vendor or PCB manufacturer, please convert the encoding and change the delimiter. 
Recommended solution: Save as a new CSV file in Excel or WPS. For example, open a CSV 
file in Excel, click or select: Save As - Other Formats - CSV (Comma Separated) (*. csv). 



You can also open the CSV file with any text editor (such as Windows Notepad) and save 
as ANSI or UTF-8 encoding. If necessary, replace all tabs with commas. 

 
 

 
 

Export DXF 
 

 

EasyEDA support to export PCB to DXF. 

At present EasyEDA supports to export a full layers and objects DXF file: 
 

You can edit it at CAD tools very easy, toggle the layers as you want. 
 

 

Export Altium Designer Format 
 

 

EasyEDA supports exporting the schematics and PCB in Altium Designer format. 

The "export to Altium" function is now in beta, Please check carefully after exporting the 
design to Altium, EasyEDA cannot guarantee that there are no errors!!! EasyEDA is not 
responsible for any loss due to library errors or format conversion!!! If you do not agree, 
please do not use Altium export!!! 

If you want to order a PCB please generate a Gerber file instead of exporting to Altium! 
Please do not export your design to Altium and import it more than once as this may 
cause some details to be lost!!! 
Altium version 19 is not supported yet, please open exported file with Altium version 18 
or before, version 17 is recommended 



.schdoc 

.pcbdoc 

If you find any errors in the export details, please contact us so we can fix it, to help us please 
include the problem details and files. 

 

 

When exporting, you must log in first before exporting. 

Exporting Schematics In Altium Designer Format 

EasyEDA supports exporting the schematics in Altium Designer format. 
Use "File > Export > Altium...", clicking "Download" will create a 

 

 

 
file. 

 

 

 

Exporting PCB in Altium Designer Format 

EasyEDA supports exporting the PCB in Altium Designer format. 

Use "File > Export > Altium..." to create a file. 
 

When opening the exported PCB file in Altium Designer there will be a dialog "DXP Import 
Wizard", don't worry, just cancel it to continue. 



 
 

Known Issues: 

1. No Copper Area fill data. 

The PCB file will look like this without copper area: 

 

 

 

 

 

 

 

 

 
You need to repour all polygons in Altium Designer using: Tools > Polygon Pours > 
Repour All: 



 
And finally, save it. 

 

 

 

 

 

 

 

 

 
 

2. No Ratlines. 



If you export the PCB without ratlines, you need to show all connections first before routing : 
Use: Design > Netlist > Clean All Nets (D > N > A),and then (V > C > S) 

 
Or use hotkey: N > H > A followed by N > S > A: 

 

 

 
3. Inner layer Plane Zone doesn't export perfectly. 

You need to rebuild the plane zone and re-assign plane zone's net. 

4. Doesn't support DRC rule. 

Please check the DRC manually. 

5. The text may be changed. 

Some text may change position depending on the chosen font. If the text does not display 
correctly just manually adjust the position. 

 

Exporting Footprint and Symbol in Altium Designer Format 

EasyEDA does not support exporting the Symbol or Footprint in Altium Designer library 
format, but you can place the libraries with the schematic or PCB and export that in Altium 
Designer format, and then extract the libraries from Altium Designer. 

EasyEDA is not responsible for any loss due to library errors or format conversion!!! If you 
do not agree to this, please do not use Altium export!!! 

 

 

 
 

Export SVG Source 
 

 



EasyEDA supports exporting or editing SVG source. 

You can create an SVG source file using: 

File > Export > SVG source... 

First copy the contents of this box into a text editor and then save the file with the 

.svg extension. You can edit it in Inkscape or open it in your browser. 

This solution doesn't need an Internet connection, you can use it off-line with EasyEDA. 
 

 

 

Export EasyEDA Source 
 

 

EasyEDA supports saving your file to local storage, you can download your design as an 
EasyEDA source file. 

1. Export EasyEDA document directly 

You can create an EasyEDA source file with: 

** > File > EasyEDA File Source...** 
 

2. Download the project 

http://www.inkscape.org/
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